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Chapter 1. Terrain Analysis using GIS I. 
 Application of Remote Sensing Datasets 

 

1 Introduction to terrain analysis and digital elevation models 

1.1 What is terrain analysis? 
Terrain analysis is an efficient tool for understanding our environment, the natural and 
anthropogenic processes, therefore we can analyze the changes of the surface, and 
become able to make predictions about these changes. Terrain analysis is the 
interpretation of the physical features of the surface. Terrain analysis is an important part 
of geomorphological research, engineering work and agricultural application as well. 
Nowadays we make these analyses through Geographic Information Systems (GIS). 

1.2 Where can we use the results of terrain analyses? 
There are several areas where we can use the results of terrain analyses. Just to mention 
a few important things we are able to calculate erosion maps based on two elevation 
models captured at two different times. In a time series analysis, we can observe the rate 
of the erosion, and we can delineate the hot spots where interventions are needed. We are 
also able to monitor the accumulation processes as well. Determining the slope and the 
aspect values are the two most common terrain analysis processes. In an engineering or 
agricultural environment these results describe the main terrain properties from the area. 
At high slope values there are increased risks of landslides or in case of snow-covered 
areas avalanches. Hydrologists use elevation models to delineate catchment areas or areas 
at risk of flooding, and they can observe river flows as well. 

1.3 What is a Digital Elevation Model (DEM) and what is the 
difference between a DEM, DTM and DSM? 

We can perform terrain analyses based on Digital Elevation Models (DEM). We must 
mention and make a difference between the DEM, the Digital Surface Model (DSM) and 
the Digital Terrain Model (DTM; Internet 1). The DEM is a raster dataset, which contains 
pixel values of the bare ground referenced to a vertical datum. The DEM does not contain 
man-made objects (e.g., buildings, bridges, or utility networks) or vegetation cover (e.g., 
trees or forests), it contains only ground points. A DEM is efficient for natural 
applications, geology, geography, and hydrology, etc. 

The DSM includes elevation values of the Earth’s surface and every natural and built 
features as well. A DSM is useful e.g., in urban management, 3D modelling, and aviation 
as well. Based on the difference of a DSM and a DEM we can derive a Normalized Digital 
Surface Model (nDSM). The nDSM contains the relative height above the ground of the 
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objects located on the surface (e.g., buildings, towers, bridges, trees, and forests). This 
elevation model is especially practical for urban planners or forestry, as well. We can 
easily determine building height or count cubic volume. 

The DTM has two definitions, the first is synonymous with the DEM, meaning that the 
DTM is a raster elevation model with pixel values referring to the bare-ground elevation 
without any man-made or natural objects. The other definition is mostly used in the 
United States. According to this a DTM is a vector dataset containing regularly spaced 
points and natural features as well. We can interpolate a DEM from a vector based DTM 
dataset, but we cannot interpolate a DTM from a DEM. 

In this note we are going to use Digital Elevation Model (DEM) in most of the cases, 
referring to raster elevation models indicating the bare-ground elevation values. 

1.4 How can we derive Digital Elevation Models, and which are the 
most popular ones? 

There are several ways to derive digital elevation models. Although traditional geodesy 
devices (e.g., levelling or theodolite) are not digital, but the data can be digitized, so a 
digital elevation model can be derived from these datasets. E.g., digitizing contour lines 
and elevation points from analogue datasets (e.g., paper topography maps). The latest 
geodesy devices (e.g., digital theodolite, total station) and the GPS devices can derive 
digital elevation points. The previously introduced methods can derive only digital 
elevation data, which we must interpolate to get a digital elevation model. There are 
several interpolation methods (e.g., Inverse Distance Weighting (IDW), Kriging, Topo 
to Raster, Natural Neighbour, and Spline) but this is not the point in this note. 

To derive digital elevation models the Light Detection and Ranging (LiDAR) technology 
is an efficient tool (Internet 2). The LiDAR is a remote sensing method which uses laser 
light to measure distances and it creates a precise 3D vector-based dataset including X, 
Y, and Z coordinates of the measured area in a specified Coordinate Reference System.  

There are three main types of laser scanning based on the scanner platform. The first is 
the Terrestrial Laser Scanning (TLS), which scans the surrounding area from a static 
position. This method is good for capturing smaller areas, buildings, interior areas, and 
individual surface objects, etc. In case of larger areas, the measurement has to be carried 
out from more than one scanner position. The second type is the Mobile Laser Scanning 
(MLS), which collects data from mobile vehicles (e.g., cars, trucks, trains, drones, or 
boats). This technique is efficient in case of measuring linear objects, like urban streets, 
tunnels, roads, highways, railways, etc. This technique is also faster compared to a TLS, 
and more efficient while capturing larger areas. The last LiDAR type is the Aerial Laser 
Scanning or Airborne Laser Scanning (ALS). In this case the sensor is mounted on an 
aerial vehicle (e.g., airplane, helicopter or drone). This technique is one of the most 
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efficient ways to collect geospatial data from large areas of the Earth’s surface. According 
to the scanner type there are topographic and bathymetric LiDAR, up to this point we 
have talked about topographic LiDAR applications, but the bathymetric application is 
important as well. By applying this method, we can map the topography of the riverbed 
and lake basins. 

By a LiDAR measurement we get a point cloud of the measured area, containing X, Y 
and Z coordinates with a specified density according to the sensor capabilities. A LiDAR 
measurement, thus the point cloud includes points from the man-made and natural surface 
objects as well. By interpolating this point cloud, we get a DSM. In case of LiDAR 
datasets there are efficient ways to select the ground points, excluding the surface objects 
from the point cloud. By interpolating the selected ground points, we get a DEM. 
Additionally, if we extract the DEM from the DSM, we get an nDSM which contains 
only the relative height of the surface objects. All in all, a LiDAR measurement could 
cover every type of the elevation models. 

Another way to derive digital elevation models is the application of photogrammetry. 
Photogrammetry uses aerial images from two or more different vantage points. It works 
like our vision, based on stereo images we can sense the depth and perspective of the 
terrain. We are able to create elevation models based on aerial stereo imagery, but 
recently using Unmanned Aerial Vehicles (UAV) i.e., drones are the most common way 
to create elevation models using photogrammetry. Based on an aerial survey we get 
overlapping images, and during the procession of these images we get a point cloud, like 
in the case of the LiDAR technology but in this case, this will be a photogrammetric point 
cloud. We can work with a photogrammetric point cloud the same way, we are able to 
select the ground points, and we are also able to interpolate the points to a DEM or DSM 
and based on these two we can calculate nDSM as well. 

The last method we mention here according to derive digital elevation models is the usage 
of satellite interferometry. We must use radar images, especially Synthetic Aperture 
Radar (SAR) to get information of the terrain. And based on radar interferometry we are 
able to calculate distances between the terrain and the sensors. We need two radar images 
to create a DEM at the same time, like in case of photogrammetry. 

One of the most important radar-based elevation models is the Shuttle Radar Topography 
Mission (SRTM; Internet 3). The mission was carried out in 2000 with an X-Band 
Synthetic Aperture Radar (X-SAR) sensor on board of the space shuttle Endeavour and 
was released globally in 2015. SRTM data is available between 60° north and 56° south 
latitude with 1 arc-second (approximately 30 meters) geometric resolution. 

Another important digital elevation model is the Advanced Spaceborne Thermal 
Emission and Reflection Radiometer (ASTER) Global Digital Elevation Model (GDEM, 
Internet 4). The first ASTER GDEM was released in 2009 based on stereo imagery 
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collected by ASTER sensor on board of the Terra satellite. The dataset has global 
coverage between 83° north and 83° south latitudes with 30 meters geometric resolution. 

There are also improved digital elevation models. In this note we are going to take an 
overview of a hybrid product, the EU-DEM (Internet 5). This digital elevation model is 
based on the fusion of the previously mentioned SRTM and ASTER GDEM datasets. 
The EU-DEM has an improved validation and accuracy, and has 25 meters geometric 
resolution over Europe, especially the EEA39 countries. This digital elevation model has 
consistency with the EU-Hydro river network and coastline databases. 

1.5 How can we access Digital Elevation Models? 
Previously we saw that we are able to create digital elevation models for ourselves using 
traditional or modern geodesy devices, GPS, or drone surveys. Surveys of LiDAR 
technology are usually taken by order and requires a significant financial investment. 
Fortunately, there are several available digital elevation models free of charge. One of 
the most useful websites is the EarthExplorer (Internet 6) where we can choose from 
several datasets, digital elevation models including SRTM and ASTER GDEM, aerial 
and satellite imagery, radar data and processed products as well. We must register to 
access the downloading option, which is free of charge, but we can browse for data 
without registration as well. In the following sections we are going to see alternative 
downloading options. 

2 Work with digital elevation models and perform terrain 
analysis 

2.1 A short introduction to the QGIS software 
QGIS is a user-friendly Open-Source Geographic Information System (GIS) licensed 
under the GNU General Public License. QGIS is an official project of the Open-Source 
Geospatial Foundation (OSGeo). It runs on Linux, Unix, Mac OSX, Windows, and 
Android and supports numerous vector, raster, and database formats and functionalities 
(Internet 7). 

We can download the QGIS software from the https://www.qgis.org/ website. In this note 
the version 3.16.11 was used. I recommend downloading and using the “Long term 
release (most stable)” version of the software (Figure 1), but the website archive contains 
all the previous releases. 
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Figure 1. Downloading QGIS Standalone Installer 

After a simple installation open the QGIS Desktop software. We can change the look of 
the software by right-clicking on an empty space in the toolbar (Figure 2). Here we can 
turn the Panels and Toolbars on and off. 

The great advantage of the QGIS software is that the possibilities are almost unlimited 
with plugins. We can manage and install plugins at the “Plugins” drop-down menu 
(Figure 3). 

 
Figure 2. Panels and toolbars 

 
Figure 3. Plugins drop down 
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2.2 Downloading and clipping elevation models 
Based on the popular SRTM elevation model we are going to take an overview of the 
visualization of Digital Elevation Models. QGIS have an “SRTM-Downloader” plugin. 
We can install it at the Plugins/Manage and Install Plugins (Figure 4). The installed 
plugin will appear at the “Plugins” drop-down menu (Figure 5). 

We are going to observe the Tokaj Hill sample area in Hungary (Coordinates, Lat/Lon: 
48.1209, 21.3817). Open an Open Street Map (OSM) basemap in QGIS. It is located at 
the Browser Panel/XYZ Tiles. Navigate to the extent of the Tokaj Hill (Figure 6) and 
open the SRTM-Downloader. Set the canvas extent or type the extent boundary 
coordinates of a specified sample area and browse the output path of the SRTM raster 
file to be downloaded and click on the Download button (Figure 7). 

To download the dataset, first we must register to the Earthdata, NASA website (Internet 
8) During the registration process select “Education” for “Affiliation”. The registration 
and downloading of the dataset are free of charge. We can see that after the downloading 
process a full tile of SRTM dataset has been downloaded (Figure 8). The tile is stored in 
a single band raster image (*.hgt). The DN values, i.e., the pixel values represent the 
elevation in meters. 

 

Figure 4. Installation of the SRTM-Downloader plugin 
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Figure 5. SRTM Downloader menu 

 

 
Figure 6. Extent of the Tokaj Hill 

To focus just on the Tokaj Hill, clip the full SRTM raster using Raster/Extraction/Clip 
Raster by Extent (Figure 9). Clipping affects the file size and therefore the processing 
time as well. We must select the input layer to be clipped, this will be the full SRTM tile 
(Figure 10). The clipping extent can be calculated from other raster layers, we can use 
the current map canvas extent, and we can simply draw a rectangle on the canvas to set 
the clipping extent. Choose the latter option (Figure 11). By default, the software saves 
the new clipped extent to a temporary file, but this time choose save to file, and select 
*.TIF for the file type. 

We can also use Raster/Extraction/Clip Raster by Mask Layer if we have an exact 
shapefile of an area, e.g., a catchment sample area. 

At this time save the project at File/Save as, to easily access our opened layers and 
settings later. Select *.qgs for the file type and don’t forget to save regularly, especially 
before exiting the software. 
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Figure 7. SRTM-Downloader window 

 
Figure 8. Extent of the full SRTM tile 
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Figure 9. Clip Raster by Extent menu 

 

 
Figure 10. Clip Raster by Extent window 
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Figure 11. Draw a rectangle on the canvas to set the clipping extent 

 

2.3 Visualization of elevation models 
At this time, we have a clipped single band raster of SRTM data of the Tokaj Hill. Let’s 
take an overview of the dataset. At the Layer properties (double click on the layer name 
or right click and select the Properties; Figure 12) go to the Information tab. Here we can 
see the name of the file, the file path, the Coordinate Reference System (CRS), the extent 
of the dataset, data unit, width and height of the raster, data type, file type, and the pixel 
size. Here we can also see a brief statistics of the dataset, maximum, mean, minimum and 
standard deviation values. Additionally, we can also calculate a bit extended basic 
statistic. Open the Toolbox at the Processing drop-down menu (Figure 13).  

At the Toolbox extend the Raster analysis menu and select the Raster layer statistics 
(Figure 14). At the pop-up window, we must select the input layer. We can save the 
statistics to a temporary file, or we can save it to a file as well. The output result will be 
a text file (Figure 15). 
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Figure 12. Opening Layer properties 

 
Figure 13. Processing Toolbox menu 

 
Figure 14. Raster layer statistics menu 



        

15 
 

 
Figure 15. The calculated statistics 

At the Layer properties Histogram tab, we can observe the pixel values distribution on a 
histogram (Figure 16). The x axis represents the pixel values, and on the y axis we see 
the frequency of the pixel values. At the Prefs/Actions button we can set different 
visualization options of the histogram, e.g., show minimum and maximum markers, draw 
histogram as lines. We can also set the minimum and maximum values. 

Now we are going to take an overview of the visualization methods of the elevation 
models. We can find the visualization settings at the Layer Properties (double click on 
the layer name or right click and select the Properties; Figure 12). At the Layer Properties 
window select the Symbology tab. By default, a singleband grey render type is set (Figure 
17). There is an option to set the minimum and maximum pixel values to be displayed. 
There are a few more options for the visualization. We can set the blending mode, change 
the brightness, gamma, contrast, and saturation as well. Let’s try these settings. 

In case of every visualization method, we can query the height values of the elevation 
model by using the Identify Features tool, located in the toolbar (Figure 18). This tool 
will show the elevation values of the pixels in the Identify Results window (Figure 19). 
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Figure 16. Raster Histogram 

 
Figure 17. Symbology settings window 
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Figure 18. Identify Features 

 
Figure 19. Identify results 

Change the render type to singleband pseudocolor. We can set different color ramps here, 
according to the characteristics of the current dataset. As we have elevation data select 
the one seen on the Figure 20. There is an option to change the interpolation type and the 
mode of the classification method. In case of Equal interval and Quantile we can set the 
number of classes manually. Additionally, we can add values manually by pressing the 
green plus icon, and we can remove values as well by pressing the red minus icon. There 
might be a need to invert the color ramp (Figure 21), like in this case we would like to 
indicate the higher values with brown and the lower values with green. The option to 
change the Color Rendering options is still there. You can see the results on the Figure 
22. 
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Figure 20. Changing the color ramp 

 
Figure 21. Invert Color Ramp 
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Figure 22. Visualizing Digital Elevation Models 

There are other visualization options like Hillshade, which simulates the exposure of the 
Sun (i.e., the source of the light), at any time of the day. There are options to set the 
altitude and the azimuth value of the Sun (Figure 23). The color rendering options are 
still there. Try to set custom altitude and azimuth values and select an overlay blending 
mode. Load an Open Street Map basemap below our elevation model and check what’s 
happening. You can see the basemap with a hillshade overlay on it, thus a better 
visualization is available due to the digital elevation model. We can also select the 
temporary and permanent shadow cover over the area using this visualization option. 

Before selecting the last visualization method (render type), the Contours (Figure 24), set 
the blending mode back to normal. In case of contour lines color rendering options make 
not much sense. With the contour lines we can visualize isolines connecting places of the 
same height. There are options to set the style of the contours, we can change the color, 
the width and the line style as well (e.g., dashed line). There is an ability to set the interval 
of the contour lines, and we can set index contour lines as well, usually visualized by a 
wider line style. This is an efficient way to indicate the elevation of an area without 
actually visualizing the raster layer of the elevation model. The result can be seen on the 
Figure 25. 
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Figure 23. Hillshade visualization options 

 
Figure 24. Visualization options of contour lines 
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Figure 25. Contour lines of the Tokaj Hill 

We can also extract the contour lines from the elevation model and export them into a 
file. We can access the Contour tool at the Raster drop-down menu, Extraction (Figure 
26). We must select an input layer, the elevation model (Figure 27). In this case we have 
a single band raster, but in case of multiband raster images we must take care of the 
number of the band. It is important to choose the proper interval value between the 
contour lines. It is a good option to check the contour lines at the visualization method 
first, as we did before. There is an option to consider the attribute field name of the height 
values. QGIS has an option to save the results into a temporary file, but if you select the 
save to file option you can see that there are a lot of file types to choose from (Figure 28). 
Now select the shapefile (*.SHP), but here we can select *.GPX file, which is easily 
compatible with GPS devices or *.KML file, which is compatible with Google Earth. 
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Figure 26. Contour menu 

 
Figure 27. Contour settings 
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Figure 28. Vector file types 

On the created shapefile we can also use the Identify Features tool to query the height 
values of the isolines (Figure 29) or we can observe the attribute table (right-click on the 
layer name and select Open Attribute Table). We can see that the height field’s name is 
what we have set before. We can also label these contour lines in the Layer properties 
(double-click on the layer name) Label tab (Figure 30). Select Single Labels at the drop-
down menu at the top of the window. At the value field select the field that contains the 
elevation values. There are a lot of labelling settings, text color, font, style, etc. Discover 
the options for yourselves. 

 
Figure 29. Identify Features 
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Figure 30. Labeling options 

2.4 Terrain Analysis 
In this section we are going to take an overview of the most important terrain analysis 
opportunities. We are going to perform the analyses on another digital elevation model, 
the EU-DEM. We can access the EU-DEM database at the site of the European 
Environmental Agency’s website (Internet 9; Figure 31). 

 
Figure 31. EU-DEM v1.1 Map View website (Internet 9) 
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In this Map View (Figure 32) we see the tiles of the EU-DEM data tiles, each of them 
has an identifier based on the geographic coordinates. To download a tile, we must 
register first, the registration and the downloading is free of charge. Let’s download the 
E50N20 tile, which contains the Tokaj Hill area (Figure 33). 

 
Figure 32. Map View of the EU-DEM v1.1 

Open the downloaded tile in QGIS, and clip the Tokaj Hill area, as we clipped the SRTM 
data tile before. We may use the clipping extent of the clipped SRTM tile. The EU-DEM 
uses a different Coordinate Reference System than WGS84, but QGIS applies on the fly 
coordinate transformation, thus there is no effect while using different Coordinate 
Reference Systems for different layers. Therefore, we see the clipped EU-DEM tile 
rotated (Figure 34). 

In case of another digital elevation model, each visualization method is still there, which 
we saw before. Let’s check them again for yourselves with this EU-DEM dataset. 
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Figure 33. Downloading EU-DEM v1.1 tiles 

 
Figure 34. Clipped EU-DEM tile of the Tokaj Hill 

We can find the most important terrain analysis tools in the Processing Toolbox at the 
Raster terrain analysis menu (Internet 10). The first is the Aspect (Figure 35). The aspect 
indicates the slope direction, and the values show the azimuth values from 0 to 360, 
starting from north (0°) to 360° clockwise. We must select the elevation model as an 
input layer. Z factor is for vertical exaggeration. This is useful to set when the X and Y 
units differ from the Z units. By default, it is set to 1, which means no exaggeration. The 
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output can be saved in a temporary file, or we can save it in a file. I recommend using 
descriptive names, which indicate the processes we made on the original elevation model 
(e.g., EU-DEM_Aspect.tif). The result layer has a singleband grey render type. Change 
it to singleband pseudocolor to achieve a more informative visualization. As the result 
layer indicates aspect values, divide them into 8 classes: north (N), northeast (NE), east 
(E), southeast (SE), south (S), southwest (SW), west (W) and northwest (NW). Select a 
Quantile mode and set 9 classes manually, as the north will have two classes (0-22.5 and 
337.5-360). Each other direction will have 45° direction range (22.5+45=67,5; 
67.5+45=112.5; etc.; Figure 36). Set different colors for each classes, only the two north 
classes will have the same symbology, practically norther values should have colder 
colors, and southern values should have warmer colors. For easier understanding fill the 
Label field with the names of the directions instead of the azimuth values. If we work a 
lot on a layer style, we can save it to use later on a similar dataset (Figure 37). We can 
see some black parts on the aspect map (Figure 38), these no data values represent flat 
terrain where no aspect values could be determined. These parts are usually open water 
surfaces. 

 
Figure 35. Calculating Aspect 
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Figure 36. Visualizing Aspect 

 

 
Figure 37. Saving symbology style 
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Figure 38. Aspect map 

The Hillshade has the same result that we saw before at the visualization settings, but 
here we can export the results into a file. Using the Hillshade we may have a better 
understanding of the relief of the area. The options to set the Azimuth and altitude 
(Vertical Angle) values are still there, representing the position of the Sun (or the source 
of the light). As an input layer, select the elevation model, do not forget to change the 
input layer, because the input layer will be the active layer any time, we open a terrain 
analysis tool and we have modified the aspect layer previously, thus this is the active 
layer at this time. In case of the output layer the values have a range from 0 (shadow) to 
255 (light). As we have seen before we can set transparency for this layer, to overlay it 
with another basemap to achieve a better visualization. 

The Relief option creates a shaded relief overview. Select the elevation model for the 
input file. We can set the relief color ranges manually, but at this time leave the tick in 
the Generate relief classes automatically checkbox (Figure 39). Save the result into a file. 
We see the result with the automatically generated relief classes in the Figure 40. This is 
a familiar visualization method of elevation models, which is used by most of the 
elevation maps. 
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Figure 39. Relief settings 

 
Figure 40. Relief map 
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We can calculate Ruggedness index at the Raster terrain analysis menu. The index shows 
the terrain heterogeneity (Riley et al. 1999). The index applies a 3x3 kernel window and 
calculates the changes in the elevation by summarizing the changes within the center and 
the surrounding pixels. 

The last tool we are going to check here is the Slope. The slope indicates the angle of 
inclination of the surface. The values are expressed in degrees. We must also define the 
input layer, the digital elevation model. Save the output result into a file (Figure 41). Set 
a more informative visualization for the result layer (Figure 42). We may specify the 
exact slope category values as well. 

In case of the SRTM dataset the slope result will not be effective this way, because it has 
different X and Y pixel sizes, moreover the X and Y units are in degrees, and the Z values 
are in meters. If we would like to work with the SRTM dataset we have to reproject the 
raster layer to another Coordinate Reference System using meter units, and we may 
operate with the Z factor during the calculation process of the slope values. In case of the 
EU-DEM dataset there are no problems like this because it has ETRS89 Lambert 
Azimutal Equal Area Coordinate Reference System, and the pixel size is equal in X and 
Y directions. 

 
Figure 41. Slope settings 
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Figure 42. Slope map 

2.5 Working with terrain data 
The Tokaj Hill is famous for its vineyards, in this section we would like to consider the 
optimal areas to grow grapes. The grapes need warm temperature, long sun exposure, and 
terrain inclination to provide optimal conditions to the plants. Take into consideration 
what kind of terrain data we have. We have slope, aspect, and of course the height values. 
From these data we would like to select the southeast to southwest aspect of the hillside, 
to reach the maximum sun exposure. We must select an optimal inclination from about 
5° to 15°. And finally, grapes do not like high elevation, so restrict our selection below 
300 m. 

In case of raster data sometimes there is a need to reclassify our pixel values. Like in this 
case we would like to reclassify our slope, aspect, and elevation layers. First reclassify 
the slope layer. We can find the tool at the Processing Toolbox/Raster analysis/Reclassify 
by table (Figure 43). For the input raster layer select the slope layer. We can set the 
reclassification values by a table (Reclassification table; Figure 44). We must add rows 
to our table, and we can also remove them from the table. We only need the slope values 
between 5 and 15, their new value will be 1. From 0 to 5 and from 15 to 90 (or the 
maximum value in our dataset) we need 0 for the new values. In the Advanced Parameters 
we can specify the Range boundaries to declare the correct relations of the table values. 
Save the result into a file with a _reclass postfix to easily identify our new reclassified 
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layer. The output raster is a Boolean layer, which contains only 0 and 1 values (Figure 
45). 

 
Figure 43. Reclassifying slope values 

As a second step reclassify the aspect layer. We need to select the southeast, south, and 
southwest aspect directions; thus, we must reclassify our slope layer as we can see it in 
Figure 46. Azimuth values from 0 to 112.5 will be 0, from 112.5 to 247.5 will be 1, and 
from 247.5 to 360 will be 0 too. Check the Advanced Parameters as in the case of the 
slope reclassification. The result Boolean layer can be seen in the Figure 47, indicating 
the southern aspects. In case you cannot see the same result, set the maximum value to 1 
at the Layer properties, Symbology tab (Figure 48). 
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Figure 44. Reclassification table of the slope layer 

 
Figure 45. Reclassified slope layer 
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Figure 46. Reclassification table of the aspect layer 

 
Figure 47. Reclassified aspect layer 
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Figure 48. Set the maximum value to 1 in case of a Boolean layer 

Finally, reclassify the original clipped EU-DEM layer. We need two rows, and the height 
values from 0 (or the minimum value of the elevation model) to 300 will be 1, and values 
from 300 to the maximum value of the elevation model (larger value can be set; Figure 
49) will be 0. The result raster shows the areas below 300 m height (Figure 50). 

Now we have three independent reclassified result layers. To get the intersection we must 
combine these layers. For this step we must use the Raster Calculator at the Raster drop-
down menu (Figure 51). At the raster bands we see the raster layers opened in QGIS. 
With a @ marker the number of the band can be seen, it is important in case of multiband 
rasters (e.g., relief). To get the intersection multiply the reclassified layers, the slope, the 
aspect, and the elevation layers (Figure 52). We can add a layer to the Raster Calculator 
Expression field by a double click on a raster band and we can choose the correct operator 
(*) from the Operators section. Multiply all the three layers and save the result into a 
GeoTIFF file. The output extent will be calculated from the input layers in this case. We 
can change the Coordinate Reference System here if necessary. 

At this time we created a layer which contains areas with the following conditions: slope 
values between 5-15°, aspect values between 112.5-247.5°, and elevation values below 
300 m. Change the visualization of this layer (Figure 53). Select Singleband pseudocolor 
render type, set the mode to Quantile with two classes. Type the values 0 and 1 to the 
Value field, set full transparency to the 0 value (Opacity value) and 20% opacity for the 
other category. 

We can see our result layer above an Open Street Map basemap layer in Figure 54. We 
can easily compare the already existing vineyard areas with our results. We can see high 
similarity, of course location of vineyards has several additional criteria, and our 
delineation and threshold values may not provide accurate outcomes, but in this note the 
processes and the workflow were the key elements. 
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Figure 49. Reclassification table of the DEM 

 
Figure 50. Reclassified DEM layer 
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Figure 51. Raster Calculator menu 

 
Figure 52. Raster Calculator settings 
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There may be a need to export the results to vector format, we can do this with the 
Poligonize (Raster to Vector) tool, located in the Raster/Conversion drop-down menu 
(Figure 55). Select the multiplied result layer as an input and save the result into a 
shapefile (Figure 56). If we need another vector file format, we can set it here. We can 
see the result on the Figure 57. As this layer contains polygons with both 0 and 1 DN 
attribute values, we are going to delete the records with 0 values. 

 
Figure 53. Symbology settings 

 
Figure 54. Result raster layer 



        

40 
 

 
Figure 55. Polygonize (Raster to Vector) menu 

 
Figure 56. Poligonize (Raster to Vector) settings 
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Figure 57. Result of the vectorization 

Open the Attribute table of the shapefile layer (right click on the layer name and select 
Open Attribute Table; Figure 58). We can see all the records of our polygons here. To 
delete the records with the 0 DN values, first select them by the Select features using an 
expression (Figure 59). In the middle of the pop-up window there is a Fields and Values 
menu, which contains the attribute fields of the shapefile (Figure 60). By double clicking 
on the DN field the software adds it to the Expression field. We would like to select 0 
values, so after an equal sign write 0 (or we can list all of the unique values or 10 samples 
on the right side of the window, which is more useful in case of text data or datasets with 
larger variance). If we are ready, we can click on the Select Features. 

In the attribute table the selected rows have been highlighted, as the features in the map 
view as well. There is an option in the attribute table to show only the selected features 
(Figure 61). To delete the selected features first we have to toggle editing mode (Figure 
62), then simply press Delete on the keyboard or click on the dedicated button at the 
toolbar (Figure 63), then Save edits (Figure 64) and toggle editing again. Additionally, 
do not forget to switch back to Show All Features. 
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Figure 58. Open Attribute Table 

 
Figure 59. Select features using an expression 
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Figure 60. Select by expression 

 
Figure 61. Show Selected Features 

 
Figure 62. Toggle editing mode 

 
Figure 63. Delete selected features 
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Figure 64. Save edits 

Now let us create a thematic map of the results. We are going to need an Open Street 
Map basemap layer, a hillshade layer and the result shapefile. Turn off the other layers, 
by removing the ticks before the layer names at the Layers panel. Take care of the proper 
layer order, from top to bottom: vector layer – raster layer – basemap. Set an overlay 
blending mode for the hillshade layer. Set a transparent fill color for the vector layer 
(Figure 65). Do not forget to save the project regularly. 

At the Project drop-down menu select New Print Layout (Figure 66) and give a name to 
the map. At the layout window we must insert every map component we need. Add Map, 
Legend, Scale Bar, and North Arrow to our map layout at the left toolbar (Figure 67). 
First select the tool, then click on the map layout. In case of the legend remove the other 
layers, in the Item Properties/Legend Items remove the tick from the Auto update and 
check the Only show items inside linked maps checkbox. You can remove the selected 
items manually as well (Figure 68). Compose the thematic map shown on the Figure 69. 
Most of the settings of the map components can be found at the Item Properties. We can 
change the name of the shapefile layer at the Layer Properties, Source tab. This setting 
only affects the visible layer name at the Layers panel, and in the map legend. 
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Figure 65. Symbology settings 

 
Figure 66. New Print Layout 
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Figure 67. Layout view – map composer 

 
Figure 68. Legend properties 
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Figure 69. Thematic map 

In this section we have learned how to perform the basic terrain analyses, and according 
to a task we processed these layers to get a result although the outcomes of the terrain 
analyses can be considered as results as well. We have learned how to create a vector 
layer from the results, and how to visualize them on a thematic map. 

Let us try to perform these analyses with other values in case of reclassification. Create 
additional thematic maps based on the result layers and create thematic maps form the 
slope and the aspect layers as well. 

2.6 Creating a terrain profile 
As we have seen it before QGIS can be extended by several plugins to make the specific 
work easier for the users. In this section we are going to see how we can create terrain 
profiles of our digital elevation model. As the first step we must install the Profile Tool 
at the Plugins drop-down menu, Manage and Install Plugins. Type profile tool in the 
Search field, select the Profile Tool and install it (Figure 70). The installed plugin can be 
found at the Plugins drop-down menu. 
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Figure 70. Installing the Profile tool plugin 

Start the Profile Tool and make the clipped EU-DEM layer active, by clicking on it at the 
Layers Panel, and after it is highlighted push the Add Layer button at the Profile Tool 
window to add our layer to the plugin (Figure 71). As the Selection is set to Temporary 
polyline at the Options section, we can draw a polyline on our elevation model to set the 
location of the terrain profile. Draw the line by vertices with a simple left click and 
finalize the line with a double click and the terrain profile will appear in the window. 
Move the cursor to any point of the graph and we will see the X (distance is map units, 
meter in this case) and Y (Z value of the elevation model) values (Figure 72). The X 
values are not ellipsoidal distances but corrected with the elevation. We are able to plot 
the slope degree or percentage values on the graph instead of the height. We can save the 
graph in *.PNG image file or *.SVG vector graphic file and we can also save the 3D line 
or the 2D graph in *.DXF format which is used by Computer-Aided Design (CAD) 
software. During saving the graph it may be useful to remove the tick from the Show 
cursor checkbox. The data of the graph is also available in a table format, which we can 
copy to clipboard and copy to clipboard with coordinates to manage the terrain profile 
data in external table managers or statistical softwares. We can also create a temporary 
point layer from the graph which we can export to a file (e.g., shapefile). If we have a 
specific line feature that we would like to use for extracting the terrain profile we must 
use different Selection at the Options (e.g., Selected polyline or Selected layer). 
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Figure 71. Profile tool - Add Layer 

 
Figure 72. Terrain profile 
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Let’s check the terrain profile of a hiking trail, which is available on the “turistautak” 
website (Internet 11; Figure 73). On the website download the ele-track.gpx file and open 
it in the QGIS by simply dragging and dropping it to the map view. At the Select Vector 
Layers to Add pop up window it is enough to select only the tracks to open (Figure 74). 
Now select the recently added track layer at the Layers Panel and set the Selection to the 
Selected Layer at the Options. We must see the height profile of the track. It is also a 
good feature in case of similar datasets to visualize the slope profile of the track to see 
the easier and harder parts of the trip (Figure 75). 

 
Figure 73. Download link to the hiking trail (Internet 11) 

 

 
Figure 74. Select Vector Layers to Add 
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Figure 75. Slope profile of the trail 

2.7 Visibility analysis 
During a visibility analysis we can delineate areas which are visible from a specified 
point. This is a viewshed map, which includes all the surrounding points visible from a 
location, thus a line-of-sight contact is needed. We must install the Visibility Analysis 
plugin at the Plugins drop-down menu, Manage and Install Plugins as we did before in 
case of the Profile Tool. We can find the installed plugin at the bottom of the Processing 
Toolbox. 

In this section we are going to observe the areas which can be covered by the TV-tower 
at the top of the Tokaj Hill. First, we have to digitize the TV-tower on a new Shapefile. 
Layer drop down menu, Create Layer/New Shapefile Layer (Figure 76). Complete the 
name, select Point for the Geometry type, leave the Coordinate Reference System 
WGS84, and add a new height attribute field with Whole Number type to our Fields List 
(Figure 77). 

Select the new layer in the Layers Panel and push the Toggle Editing button at the toolbar 
(Figure 78) and push the Add Point Feature (Figure 79). Zoom in to the center of the hill 
and click left on the TV-tower to capture the point feature. The height of the tower is 112 
meters, so type this value into the height field of the pop-up attribute window (Figure 
80). Now we have the point feature, so Save Layer Edits and Toggle Editing again. 
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Figure 76. New Shapefile Layer menu 

 
Figure 77. New Shapefile Layer settings 

 
Figure 78. Toggle editing mode 
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Figure 79. Add Point Feature 

 
Figure 80. Feature Attribute pop up window 

As the first step find the Visibility analysis menu at the Processing Toolbox (Figure 81). 
Based on the shapefile we have created we must create viewpoints. The Observer 
location(s) will be the shapefile layer we created, in this case select the full EU-DEM tile, 
if you kept only the clipped elevation model then work with that dataset. Set the Radius 
of analysis to 20000, assume that 20 km is the range of the transmitter. The Observer 
height is set to 1.6 m by default, but as we created a height field set it to 0 and set the 
height field at the following option and save it to a shapefile (Figure 82). 

This step only converted our shapefile’s attribute table to another structure as an input 
for the calculation of the viewshed. Select the Viewshed menu, the Analysis type will be 
Binary viewshed, to get a Boolean raster layer, indicate the areas with a clear line-of-
sight with DN values 1, and the other DN values 0. Select the full tile of EU-DEM for 
the digital elevation model and save the results into a GeoTIFF file (Figure 83). 

In case of the full EU-DEM tile the processing time may be a bit longer, but after the 
processing we get the result raster layer (Figure 84). We can also polygonise this layer 
and keep only the clear line-of-sight polygons. Create a thematic map from this layer, as 
we did it previously in case of the optimal vineyard areas. 
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Figure 81. Visibility analysis menu 

 
Figure 82. Create viewpoints settings 
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Figure 83. Viewshed settings 

 
Figure 84. Viewshed map  
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Chapter 2. Terrain Analysis using GIS II.  
Application of High-Resolution UAV Data 

1 Introduction to the dataset for the tasks 
 
Typically, the concept of Unmanned Aerial Vehicle (UAV) -based aerial mapping is to 
perform several repeated flights over the area of interest and take images. These are later 
input to photogrammetric processing, in order to develop orthoimages and tridimensional 
models. Contrary to the classical stereophotogrammetry concept, nowadays, the so-called 
“structure-from-motion (SfM) method is used in general UAV-based mapping, for 
defining aerial image orientation and the orientation parameters (Szabó et al. 2018). 
 
The aerial survey had been performed using a DJI Matrice 210 v2 RTK UAV (Figure 85) 
and a DJI Zenmuse X7 DL 24mm F2.8 LS ASPH lens.  
 

 
Figure 85. DJI Matrice 210 V2 RTK UAV 

The images were taken from an altitude of 120 meters during the aerial survey. The 
forward and side overlap between the flight paths were 70-70% respectively (Figure 86).  
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Figure 86. The flight plan used for aerial mapping in DJI Pilot 

No ground control points (GCP) were used in the survey, as the aforementioned drone 
allowed direct georeferencing. This means that all images produced were geodetically 
accurate coordinates, so that no subsequent georeferencing based on GCPs was 
necessary, no external orientation was required. This operation was made possible by the 
use of the DJI D-RTK 2 base station (Figure 87). 
 

 
Figure 87. The D-RTK 2 base station at the survey site 
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During the drone survey, the coordinates of the images were recorded in the WGS84 
projection system. At the start of the work, the coordinates of the base station position 
were measured using a Stonex S9i GNSS instrument with a horizontal accuracy of ±3 cm 
and a vertical accuracy of ±5 cm. The measurement was performed using the VITEL2014 
correction data in HD72/EOV projection system. The drone records the coordinates of 
the images during the measurement in WGS84 projection system. In order to be able to 
enter the coordinates of the position we measured into the drone's control system, we had 
to transform the coordinate. Using an online EHT transformation (http://eht.gnssnet.hu/), 
we converted the HD72/EOV coordinates to WGS84 there on the spot via an internet 
connection, and finally the drone used these to record the geotags. 
 
During the drone aerial survey, a total of 627 images were taken (Figure 88) from a height 
of 120 meters. Photogrammetric processing of the aerial images collected by the drone 
was performed in Agisoft Metashape 1.5.4 software. 
 

 
Figure 88. Samples from the aerial imagery taken from the study area with the UAV 

 



        

60 
 

 
Figure 89. Number of overlapping aerial photographs over the study area 

(Source: Agisoft Metashape report) 

The Figure 89. shows that the western side of the study area had the highest number of 
overlaps (min. 9), while the eastern side had only 4-5. The reason for this is that the 
survey was carried out from a constant flight altitude, but there are significant differences 
in altitude on the mountain side, so that the images on the eastern side were taken much 
closer to the surface. 
The Table 1. shows that the drone took the images in only a very slightly different 
position compared to the flight plan: the average horizontal deviation was less than 2 cm, 
while the average vertical deviation was around 0.5 cm. 
 

Table 1. Average differences in the position of the photos 
(Source: Agisoft Metashape report) 

X error (mm) Y error (mm) Z error (mm) 
XY error 

(mm) 
Total error 

(mm) 
1.54507 1.8172 5.22684 2.38526 5.74537 

 
The Figure 90. illustrates the deviations of the position of the images from the flight plan. 
The colors in the upper right corner of the image indicate the size of each deviation in 
cm. 



        

61 
 

 
Figure 90. Deviations in the position of the final images compared to the flight plan 

(Source: Agisoft Metashape report) 

During the photogrammetric processing, first the coordinates of the images were 
converted to HD72/EOV cartographic reference system and then the images were aligned 
in the software. A so-called dense point cloud was then generated, containing a total of 
474,784,139 points (Figure 91). Based on the point cloud, the software performed spatial 
interpolation and produced a DSM (Digital Surface Model) with a spatial resolution of 
3.79cm/pixel. The density of the point cloud identified in the DSM area was 698 
points/m2. The DSM allowed the orthorectification of the images, resulting in a digital 
orthophoto mosaic of the area. The resolution of the orthophoto was 1.89 cm/pixel. 
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Figure 91. Sparse (top) and Dense (bottom) point clouds generated for the study area 

The result of the drone survey is an orthophoto of the area. The survey covered an area 
of approximately 0.472 km2. Thanks to the accuracy of the orthophoto, the gully system, 
the surrounding catchment area, vegetation and surface objects can be clearly observed. 
The results of the survey are shown in Figure 92 and 93. 
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Figure 92. Digital orthophoto of the study area 

 
On the left side of the Figure 92, you can see the total area surveyed by drone, with the 
red square indicating the area of the erosion trench under investigation. On the right side 
of the image, you can see closer images of the gully system. The top right image shows 
the entire area of the gully system with surrounding objects and land, while the bottom 
right image shows the northern part of the trench. The images show a large amount of 
vegetation, which had to be removed to carry out the terrain analysis. 
 
The orthophoto was used to produce the digital surface model of the area, illustrated in 
Figure 93. The model provides accurate information on the elevation of the area, which 
ranges between 135 and 267 meters above sea level. 
 
Like the orthophoto, the digital surface model plot shows the total surveyed area and the 
surveyed trench. It can be observed that the eastern edge of the area has higher elevation 
values, while the western edge has lower elevation values. The area in blue in the southern 
part of the image represents the elevation of the Tarcal mine. According to the figure, the 
elevation of the erosion trench above sea level is approximately 160-170 meters. In the 
figure in the bottom right-hand corner, the ditch and the vegetation along its edge are 
clearly distinguishable, and it is also noticeable that the ditch becomes steadily deeper as 
it moves southwards, while the northern part of the ditch starts from the surface of the 
catchment area and is higher up. 
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Figure 93. Digital surface model of the study area 

 

2 Post-processing of the UAV-based point clouds 
 
Our terrain analysis will be valid only in case we use digital terrain data, but the UAV 
photogrammetry provide digital surface data since many artificial objects like vegetation, 
buildings, etc. are also reconstructed during the process. Therefore, in the first step we 
must somehow remove all the surface points. The ground filters or ground classifier 
algorithms are designed for this purpose. CloudCompare is a free and open-source point 
cloud processing software that we will use for this training. CANUPO is an automatic 
point cloud classifier plugin within CloudCompare that works on the nearest neighbour 
principle. Small training areas are manually selected for classification, which are saved 
as *.prm files. Then, using one of the training areas created, the plugin examines the point 
data and splits the point cloud into two classes.  
 
First, load our UAV-based point cloud into CloudCompare. In case we apply long 
projected coordinate system-based coordinates like UTM and HD72/EOV, the 
CloudCompare is going to suggest rescaling these cartographic informations, since their 
digits are too long for detailed processing (Figure 94). You can click Yes to move on, 
and then the original coordinates will be transformed into a new local coordinate system. 
The transformation matrix is stored, therefore, in case of a final point cloud export the 
original coordinate system can be turned back. 
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Figure 94. The coordinate rescaling at the point cloud opening stage at CloudCompare 

 
Contrary to the Airborne Laser Scanning-based, LiDAR (Light Detection and Ranging) 
datasets, the UAV-based point clouds do not have any return values, therefore, the ground 
classification must be performed based on geometric characteristics and structure of the 
point cloud.  
 
The first step before using the CANUPO plugin is to create so-called training datasets 
which are selected pieces of the original point cloud. The CANUPO will classify the 
point cloud into two main categories: 1) points show major similarities to the training 
data and 2) rest of the point cloud. Therefore, at one stage of CANUPO, multi-class 
classification is not possible. The analysis is performed using machine learning 
algorithms; thus, we should select as much similar objects that are possible to appear in 
many ways along the study area.  
In order to create the training data of, for example medium/high vegetation, zoom into 
the point cloud and manually segment some parts of it. First, select the appropriate point 
cloud in the DB tree list of CloudCompare, then, click on the Segment tool (Figure 95).  
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Figure 95. Application of Segment tool in CloudCompare 

In the following window, the polygonal selection will be enabled (Figure 96). In this 
stage, the user can start manually drawing a polygon around the feature that is the training 
feature. In our case, try to mark several different tree patches. We can easily start clicking 
with our left mouse button and at the end click with the right mouse button the polygon 
can be fixed. The next step is to click on the ‘Segment In’ tool to make a subsegment of 
the original point cloud based on the polygon we draw.  
 

 
Figure 96. The training data marking in the Segment tool 
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The next window will show the outline of the segmentation operation; however, this is 
only a ‘PAUSED’ phase that can be even restarted in case we do not find the polygon to 
be correct for our purpose.  
 
 

 
Figure 97. The segmented subset of the point cloud training data 

 
 
If we approve, then the next operation is based on clicking on the green tick mark. After 
the segmentation process, the point cloud segments will be extracted from the original 
point clouds, and both will appear in the DB tree as separated point clouds (Figure 97). 
They can be easily switched on and off for further operations (Figure 98).  
The task will be now to create several training segments (like around 10-20 of them) for 
vegetation classification. It is necessary to carry out an exhausting sampling of these 
training cases in order to a more accurate classification. It is also required to provide 
approximately similar point numbers for each training data occurrences.  
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Figure 98. Point cloud segmentation process 

 
Once we have finished the training dataset preparations, then we have to merge these 
point could segments into one single point cloud using the ‘Merge multiple clouds’ tool 
after selecting the appropriate clouds from the DB tree (Figure 99). Generating a scalar 
field with the original could index is suggested. 
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Figure 99. Overview of the vegetation training segments over the study area 

 
The next step will be to ‘Train’ the CANUPO classifier by defining which point clouds 
contain the two main categories for the classification (Figure 100). For this purpose, click 
on Plugins > CANUPO > Train classifier. Our case is easy in case we have only two 
point clouds in the DB tree. On the list, we can see which cloud refers to which category.  
 

 
Figure 100. The CANUPO training window 

 
The classification evaluation is plotted in the next window (Figure 101) by the projection 
of all descriptors in the classification space, where the magenta line represents the 
classification boundary.  
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Figure 101. The CANUPO training result example 

 
The training data then can be saved as an *.prm file by clicking on the ‘Save’ button. 
Please keep in mind that point cloud classification has extremely high system memory 
demand. Therefore, in case you do not how at least 16/32 gigabyte RAM memory, then 
it is highly recommended to subsample the total set of points (Figure 102). 
 

 
Figure 102. Subsample tool in CloudCompare 
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Users can choose from three different sampling methods: 1) random; 2) space and 3) 
octree. The UAV-based point clouds are usually consisted of extremely high number of 
points with a remarkable point density per square meters, therefore, there is a fair amount 
of points for the random sampling. The slider can be used for manually defining the 
required number of points based on the available maximum amount (Figure 103). The 
sample dataset has more than 400 million points and according to this, only 100-150 
million would be an acceptable amount.  
 

 
Figure 103. Subsampling setup in CloudCompare 

 
The CANUPO classification can be initiated by clicking on Plugins > CANUPO > 
Classify. We can even run another subsampling of the point cloud if necessary (Figure 
104). The classification process is time-consuming, thus, be patient.  
 

  
Figure 104. CANUPO classification in CloudCompare 
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The result of the classification is presented in Figure 105, where the blue color indicates 
the vegetation, and the red color indicates the ground surface. The image shows that there 
is more vegetation on the point cloud of the area surveyed by the drone than on the 
surface. In contrast, the number of points shows that the surface is composed of more 
points (Table 2). 
 

 
Figure 105. Results of the CANUPO filtering 

 
Table 2. Distribution of CANUPO classification points (without subsampling) 

Total number of points 474,784,139 
Number of surface points 283,620,415 

Number of vegetation points 191,163,724 
 
The result can be recolorized using the point 
cloud properties window (Figure 106). If we 
switch back from the classification-based scalar 
field to RGB, then it is possible to check the 
classification results. Figure 107. shows clearly 
that our classification was effective since the 
vegetation patches are significantly covered by 
the red points 
 
 

              Figure 106. Scalar-field based colorization 
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Figure 107. Results of the CANUPO classification on RGB (top) and a false color (bottom) point 

clouds 
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3 Digital Terrain Model generation  

At this stage, we can acknowledge that finally, the red-coded point cloud represents the 
ground points, therefore, we are ready to generate a Digital Terrain Model. For this 
purpose, we have to export the ground points from CloudCompare to a single point cloud 
file. We can perform this step by clicking on Edit > Scalar fields > Filter by value. In the 
pop-up window (Figure 108), we shall select the appropriate ground class value, which 
is in this case, number 2. We have to type 2 to 2 as a selectable range, then click on 
Export.  
 

 
Figure 108. Scalar field filtering in CloudCompare 

The extracted ground point cloud will now appear in the DB tree, from where, we can 
now save as a LAS cloud file (*.las, *.laz) (Figure 109).  
 

 
Figure 109. Point cloud export in CloudCompare 

The point cloud interpolation to a Digital Terrain Model can be performed in 
CloudCompare as well. Select the appropriate ground point cloud and click on Tools > 
Projections > Rasterize (Figure 110).  
It is also an important task to decide an effective and reasonable spatial resolution, or in 
other words, the pixel size of the output DTM raster. In our case, we decided to apply a 
20 cm (0.2 m) resolution. This value will also lead to an extensive processing phase, but 
the local hydrological features would not be recognizable if we choose a too coarse (like 
1 meter/pixel) spatial resolution.  
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Figure 110. Point cloud rasterization in CloudCompare 

The active layer should be the ‘Height grid values’ while the ‘Projection’ type should be 
‘Z’ value to be selected. As we are looking for the planform view of the terrain, then we 
have to apply the maximum cell heights in each given pixel. Important step is that we 
should not leave any empty cells since the purpose of this procedure is the creation of a 
continuous raster file. Therefore, we should apply the ‘Fill with interpolate’ option at the 
‘Empty cells’ block. As a final step, click on the Update grid button to preview the DTM 
to be generated by CloudCompare.  
At the bottom of the window at the ‘Export’ block, we should click on ‘Raster’ then 
‘Export heights’ then the only task is to select a proper file name to the new GeoTIFF 
file. 
 
The exported raster DTM can be now loaded into QGIS (Figure 111). If we open it, it 
will be realized that the raster has a few issues that have to be corrected. First of all, the 
raster is a plotted into a perfect square-shaped matrix. A more effective way of processing 
would be possible if the raster is well-clipped by an outline polygon that can be easily 
specified by the user. That is also an issue that the overlaying black raster pixels are 
assigned with an elevation value of 0, and this does not make it possible to apply an 
effective visualization by the value stretching.  
 
Our task will be to create a new polygon shape file in QGIS (Layer > Create Layer > 
New Shapefile Layer) as a polygon feature type. In case we have an UAV aerial survey, 
then the orthomosaic is available for vectorizing a borderline. In case you are working 
with freely available data, then a QuickMapServices WMS layer of any world imagery 
is also acceptable for this purpose. 
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Figure 111. The UAV-based and ground-classified DTM of the study area 

 
In our case, I have created the polygon in a way that leaves the outer edges of the area 
(Figure 112). It is also important to mention that the edges of the UAV-based 
DTMs/DSMs are affected by distortions, therefore, false elevation values could provide 
inaccurate hydrological derivatives. At the southern edge of the area the Tarcal Mine 
Lake is also captured; those rocky edges should be also omitted from the analysis.  
 

 
Figure 112. The new outline polygon in red for the DTM clipping 
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After vectorizing the outline polygon, save the shapefile to make it ready for the DTM 
clipping. Click on Raster > Extraction > Clip raster by mask layer tool (Figure 113). The 
‘Input layer’ will the DTM we have created previously, while the ‘Mask layer’ has to be 
the recently created polygon shapefile. You have the possibility to setup the Coordinate 
Reference System (CRS) for the clipping, that means, that the output raster can be 
transformed into another projection system directly through the process algorithm. If you 
scroll down to the bottom of this clipping window, it is also worth to decide what would 
be the data type of the output. Generally, I recommend using the ‘Use Input Data Type’ 
option, but in special cases there could be a need to create a new raster as a float, integer, 
etc. type. At the bottom of the tool settings window, at the ‘Clipped (mask)’ part, I suggest 
using the ‘Save to a File’ option instead of a temporary file. At this stage, you have the 
possibility to choose from several GIS file types and extensions. In order to avoid the 
black overlay pixels having an elevation value of zero, I recommend to setup two other 
settings: 1) please type ‘-9999’ into the ‘Assign a specified nodata value to output bands’; 
and 2) put a tick mark into the ‘Create an output alpha band’. The clip results are shown 
on Figure 114. 
 

 
Figure 113. Raster DTM extraction in QGIS 

 
Figure 114. The clipped DTM of the study area in QGIS 
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The rest of the Terrain Analysis will be performed in the freely available and open-source 
SAGA GIS software (Figure 115). This software is specially designed for a wide range 
of GIS analysis and one of its main advantages relies on the terrain analysis modules. 
The SAGA abbreviaton is referred to the “System for Automated Geoscientific 
Analyses”. A few of its tools are already implemented in the QGIS installation but I 
highly recommend to install a separate, standalone version of the full SAGA package that 
can be dowloaded from the official SAGA website. Since SAGA is an open source 
software, there is a remarkable progress on the development side, which generally results 
in rapid improvements on the spatial algorythms. Therefore, I always recommend to 
always download and install the most recent version of SAGA (Figure 116). 
 

 
Figure 115. The SAGA GIS homepage 

 

 
Figure 116. The SAGA GIS download page 
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After the installation and opening, the SAGA main window will appear (Figure 117). The 
software GUI (Graphical User Interface) has a clean and simple design where it is easy 
to navigate. In the general settings the main window is occupied by a large working 
canvas which is dedicated to plot the spatial data that we are about to use. At the 
‘Geoprocessing’ menu, an extensive list of analytical features is available for our 
purposes. At the ‘Manager’ block in the ‘Tools’ tab we have also the opportunity to 
browse from several type of operations. The ‘Data’ and ‘Maps’ tabs are responsible to 
navigate within the spatial data files that we use through our workflows. 
 

 
Figure 117. The general view of the SAGA workspace 

 
A quick remark: SAGA does not support the general TIFF files from QGIS; therefore, an 
additional file conversion must be carried out. The so-called ‘Surfer GRID’ file is more 
effective for working in SAGA and this procedure is also possible to perform in QGIS. 
In the Processing Toolbox of QGIS type the term ‘translate’. From the list, choose the 
following tool: ‘GDAL > Raster conversion > Translate (convert format)’. This will make 
it possible to convert your DTM stored in GeoTIFF format into a *.grd file as a Surfer 
grid. At the bottom of the tool settings window, at the ‘Converted’ tab, I suggest using 
the ‘Save to File’ option instead of a temporary file. At this stage, you have the possibility 
to choose from several GIS file types and extensions. From this list, you have to find and 
pick the ‘GRD files (*.grd)’ option for the conversion to a SURFER GRID. Please give 
an update filename to your raster DTM and start the conversion. Keep it in mind that the 
conversion could take a bit more time so be patient. 
After the conversion finished you can open the DTM in SAGA by clicking on 
‘Geoprocessing > File > Grid > Import > Import Surfer Grid’. If the opening procedure 
has been executed successfully, then you have a system message at the bottom of the 
working window with this statement, moreover, at the ‘Grids’ list of ‘Data’ tab the DTM 
grid will appear. In that case, you can just easily double click on that file to load the DTM 
into the main canvas of SAGA (Figure 118).  
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Figure 118. DTM loaded into SAGA 

The dark overlay will appear again, but in the ‘Properties’ window, within the ‘Settings’ 
tab and ‘Transparency’ you can set up the grid system of the DTM and click on ‘Apply’. 
Finally, your DTM will hide the overlaying and dark ‘nodata’ pixels (Figure 119). 
 

 
Figure 119. DTM with transparent alpha channel in SAGA 

You can have a look on the ‘Properties’ window of SAGA. If you select the ‘Settings’ 
tab, then several opportunities will appear, i.e., to change the color scheme for the DTM 
visualization, or even to set a transparency level. At the ‘Legend’ tab you can plot the 
legend of the values represented by the DTM, in this case, the elevation ranges of course. 
At the ‘Description’ tab a comprehensive list of metadata can be accessed for further 
purposes. 
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The next set of procedures will be associated with the derivation of several topographic 
features for a more sophisticated hydrological characterization of the studied 
geographical settings. The DTM that we have already prepared through the previous step 
is almost ready for the postprocessing stage. 

4 Preprocessing of the DTM for Hydrological analysis 
(Drainage delineation) 

The main principle behind drainage network delineation of overland flow is the 
physically sound assumption that water always flows downhill in the direction of the 
greatest surface gradient. At this point, it should be noted that the movement of water in 
lowland areas is not necessarily determined by topography, and the following analyses 
are therefore applicable primarily to hilly and mountainous areas with more pronounced 
topography. 
If we trace the path of the runoff from cell to cell, we get the runoff paths, and from these 
we can select the lines that have a lot of water flowing through them, which become the 
water courses. In this way, we can also determine the cells from which water reaches a 
given point, and thus determine the catchment area. The pioneers of the geomorphometric 
perspective soon encountered two problems, which are stated here in advance so that the 
steps of the algorithm can be understood: 

1. Without pre-treatment of DTM, flow paths will be made up of only small 
fragments, with no coherent stream network. The reason is that DTMs are 
virtually always full of "pits" (also known as sinks). These are cells that are 
situated lower than all their neighbors, therefore, water does not flow from them. 
These pits may exist (e.g., karst pits, depressions in glacial terrain), in which case 
there is indeed no coherent water network, but in most cases, it is some kind error 
in the DTM. This error may be a data error, it may be the result of interpolation, 
or it may be that a narrow exit is not represented in the DTM due to poor 
resolution. Therefore, as part of the pre-treatment, these holes should be filled in 
the DTM (Figure 120). 

 

 
Figure 120. Concept of DEM sink filling and peak removal of a Digital Terrain Model in GIS  

(Source: Internet 1) 
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2. For part of the area covered by the DTM, we often have a vector water network 
(or possibly an accurate topographic map). Without pre-treatment, the derived 
water network may differ to some extent from the water network given in vector 
form, which is obviously not always acceptable. This error is typically found on 
flat terrain in broad valley bottoms where the topography no longer sufficiently 
determines the location of watercourses. To correct for this error, the 'burn-in' of 
watercourses can be a solution (Figure 121). 

 

 
Figure 121. Effect of incorrect drainage network delineation based on a DTM having errors 
(left); Improved drainage network delineation by ‘burning in’ the location of the major river 

network (right)  
(Source: Internet 2) 

In this regard, it is now possible to understand the steps of the algorithm: 
 

 ‘Burn’ Rivers: along the lines of the vectorially given watercourses, the DTM 
is sunk, i.e., the bed is burned into the DTM. Technically, this can be done, for 
example, by using the vector watercourses into a raster space of ~3 meters along 
the watercourses, 0 otherwise, and then subtracting this from the original DTM. 

 Fill Sinks: Closed depressions are filled to the same level as the lowest point of 
the rim, i.e., as if the water fills the depression and forms a lake with run-off 
through the lowest point of the rim. This is an iterative process, because a filled 
cell may block the path of water flowing from another cell, thus creating a new 
pit. Therefore, it is necessary to repeat the filling until the until the pits are 
completely depleted. This is worth being aware of in order to understand why the 
software repeats certain steps several times to perform this operation during this 
process. 
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5 The Basic Terrain Analysis in SAGA 
 
The SAGA has several in-built Geoprocessing Tools for Terrain Analysis, like: 
‘Channels’, ‘Climate and Weather’, ‘Coastal Morphology’, ‘Hydrology’, ‘Lighting’, 
‘Morphometry’, ‘Preprocessing’, ‘Profiles’, ‘Slope Stability’, ‘Terrain Classification’. 
They also have several more detailed tools for the widespread geomorphological 
purposes, and they can be performed separately. For a beginner GIS user, SAGA has 
designed a ‘collector’ tool called ‘Basic Terrain Analysis’ which is a straightforward set 
of analysis steps. The SAGA developers have decided to implement the most important 
terrain analysis outputs that can be derived from a Digital Surface or Terrain Model.  
The tool can be reached by clicking to Geoprocessing > Terrain Analysis > Basic Terrain 
Analysis (Figure 122). At the pop-up window we will see that list of derivatives that we 
could start processing. The only thing that you need is a Digital Terrain Model or Digital 
Surface Model, that we have already preprocessed in the previous steps. At the ‘Grid 
System’ field you can select the relevant data from your list, which at the moment 
contains only one DTM raster. At the ‘Elevation’ field you should select this as well. 
 

 
Figure 122. The Basic Terrain Analysis tool in SAGA 

In case you leave the default option as ‘<create>’, then the given derivative will be 
intended to be processed. It is also possible to select an already processed feature, when 
you are about to make a revised version of any of this list.  
You have to keep in mind that this list of features requires processing resources of your 
personal computer. In case you are about to process a large dataset with a relatively high 
spatial resolution, then you can expect an extensive processing progress.  
Once the processing stage has finished, the list of new raster and vector data files will 
appear at the ‘Data’ tab of the ‘Manager’ block (Figure 123). You can visualize all of it 
by double clicking on them and selecting a ‘New’ map.  
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Figure 123. The resulted terrain features by Basic Terrain Analysis in SAGA 

If we open the first result of the ‘Analytical Hillshading’ raster (Figure 124), then we will 
experience some errors of the data. However, we have observed an acceptable amount of 
point from the UAV-based point cloud, which were classified as ground point. We have 
used them as a base data for the generation of the Digital Terrain Model, however, the 
hillshade model still have several features of vegetation  
 

 
Figure 124. Preview of the Analytical Hillshade of the DTM in SAGA 
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In this case, we have to main options. First of all, we can continue the ground point 
classification with the CANUPO filter with increased number and more precise training 
data in terms of vegetation, in order to derive more accurately the surface points. The 
other option in other case is that generally, these intensive vegetation paths are mainly 
characterize the study area during the whole vegetation period, especially, the 
accumulated wine stocks. The rainfall-generated runoff will flow through these patches 
and positive surface features; therefore, the hydrological assessment could end in an 
acceptable state.  
If we have a closer look on the details of the orthomosaic of the area (Figure 125), we 
can observe that these really dense patches of bushes and trees cover extensive land 
segments. They are also associated with significant shadow effects as well, which is the 
weak point of the UAV-based aerial photogrammetry and surface reconstruction. In these 
circumstances, the algorithm hardly able to precisely classify into ground and non-ground 
points. An active remote sensing method, like the Light Detection and Ranging (LiDAR) 
could pass their laser beams through these kinds of canopies and hit the ground but aerial 
photogrammetry is a passive remote sensing method; therefore, not capable for these 
kinds of features. 
 

 
Figure 125. Dense vegetation patches of the area previewed on the UAV-based orthomosaic 

The Slope and Aspect rasters are created similarly to the process introduced in Chapter 
1.  
 
The next two new rasters are the Plan curvature and Profile curvature. If we look at the 
change in slope angle, i.e., where the slope increases and where it decreases, we can talk 
about curvature. A slope is convex if it becomes steeper as it descends, and concave if it 
becomes less steep as it descends. Although there are exceptions, we can say that hilltops 
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and ridges are convex forms, and valleys are concave forms. It should be noted here that, 
unlike geographers, mathematicians look at functions from below, so that for them 
valleys are convex and hills concave. This difference only matters in the sign, so the 
curvature of valleys will be positive and that of hills negative. 
The curvature is mathematically the slope of the slope, i.e., the second derivative of the 
original function. For a surface, it is partially similar to the slope. Here too there are 
directional second derivatives which can be used to determine the curvature. There are 
several types of curvature (Figure 126-127): 

1. Profile curvature: This is the curvature calculated in the direction of the 
maximum slope. Imagine cutting the surface with a vertical plane perpendicular 
to the level line and examining the point in this plane curvature of that point. 

2. Plan curvature: This is calculated by intersecting the surface with a horizontal 
plane, so the result is the curvature of the level lines. Ultimately, this also shows 
the valleys and ridges, since on a contour line map the experienced geographer 
eye can identify these shapes precisely by their curvature. 

The curvature is also plotted on a color gradient map (Figure 128). Since the main shape 
difference is between the points with positive and negative curvature, it is useful to set 
the color scale so that it is white (transparent) at 0 and different colors in the positive and 
negative directions. Again, because of the extreme values that are commonly found, it is 
recommended to manually adjust the extreme values of the color scale or to use a color 
adjustment based on the data distribution. 
 

 
Figure 126. The concept of Plan Curvature 

(Source: Internet 3) 

 
Figure 127. The concept of Profile Curvature 

(Source: Internet 3) 



        

87 
 

 
Figure 128. Preview of the Plan Curvature results in SAGA 

The next derivative is the Convergence index (Figure 129). Which is in more precisely, 
the convergence index per cell, that characterizes the divergent (divergent, convergence 
index positive) and convergent (convergent, convergence index negative) nature of the 
surface runoff. The values can be derived from the curvature values. The ridge regions, 
which also define the boundaries of the catchments, are thus located in the dissipation 
zones, while the valley bottoms are located at the bottom of the conflux zone. 
 

 
Figure 129. Preview of the Convergence Index results in SAGA 

The ‘Closed Depressions’ are associated with those proportions of the land which can be 
classified as extensive low-lying areas where the flow could be concentrated without 
further overflow. In case of drainage network delineation, these depressions must be 
identified based on the DTM characteristics and must ‘filled’ without the further 
hydrological processing steps. 
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Figure 130. Preview of the Closed Depressions results in SAGA 

What we can observe after checking the results of the ‘Closed Depressions’ process, is 
an error at the western side of the study area (Figure 130). This can be difficult to reveal 
the issues at the beginner level, therefore, a possible solution can be if we just simply clip 
the raster with a polygon mask feature. SAGA has the ability to clip all our loaded and 
generated rasters in a batch process based on a polygon shapefile specified by the user. 
First of all, we have to load our shape file that contains the new extent of the area by 
clicking to File > Shapes > Load. Our shapefile will appear now at the ‘Shapes’ tab of 
the ‘Manager’ window. If we double click on the shapefile, then we can even plot it to 
our ‘Closed Depressions’ raster (Figure 131). We can do few changes in the symbology 
settings to visualize it in a more effective way, like shifting it to transparent feature with 
a thick outline. Now, this will be our mask layer for the clipping procedure.  
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Figure 131. The polygon shapefile, for the raster clipping, plotted on the ‘Closed Depressions’ 

raster in SAGA 

The necessary clipping tool can be launched by clicking to Geoprocessing > Grid > Grid 
System > Clip Grids (Figure 132). At the Grid System, we have to choose the appropriate 
grid system of the study area DTM, then at the grids list we can easily move all our 
already processed raster to the right tab of the window by clicking on the right arrow, 
then click Okay. 
 

 
Figure 132. The grid selector window of the Clip Grids tool in SAGA 

 
At the next step we have to select the appropriate polygon for the clipping (Figure 133). 
In case we have not loaded already as the previous steps, then we will not be able to 
browse that from our computer. Only if it has been loaded. Now, we can run the Clip 
Grids tool. 



        

90 
 

 
Figure 133. The polygon selector of the Clip Grids tool in SAGA 

As a result, a new set of raster grids will appear at the ‘Data’ tab of the ‘Manager’ window 
of SAGA (Figure 134). These new files have a slightly different grid system since the 
original rasters had been clipped and the new rasters have now different extents and pixel 
distribution. If we open the recent version of the ‘Closed Depressions’ raster then we will 
see the correct new raster file that has the edges fitted to the outline polygon, while the 
alpha layer also acts perfectly as the unnecessary raster pixels of the square shape remain 
transparent (Figure 135). Furthermore, now we can have an overall look of the spatial 
and size distribution of these kinds of depressions identified on the study area. According 
to the DTM, several larger patches are found that can act as potential inflow collectors. 
We will see in the further steps how these features are associated with the effectiveness 
of the drainage network delineation.  
 

 
Figure 134. The new set of Grid systems at the Manager window in SAGA 



        

91 
 

 
Figure 135. The updated ‘Closed Depressions’ results in SAGA 

LS factor 
In connection with the modelling of erosion processes, the LS factor of the Revised 
Universal Soil Loss Equation (RUSLE), which initially contributes to the estimation of 
annual soil loss as a function of slope length and slope angle, can be calculated from the 
topography model. The LS factor is determined using the following equation: 
 

 
 
where m=0.4 and n=1.3, A is the cell above and β is the local slope angle. 
 
In the processing of LS factor in SAGA the Moore-method were applied. The results 
clearly highlight those areas that have a major influence on the initiation of soil erosion 
regarding the slope angle and slope length (Figure 136). These pixels are colored in 
brownish and mainly associated with linear topographical features.  
 



        

92 
 

 
Figure 136. Preview of the LS-Factor results in SAGA 

Topographic Wetness Index (TWI) 
The Topographic Wetness Index (TWI) in hydrological modelling is related to soil 
moisture content and is given by the equation of (A/tanβ), where A is the catchment area 
above the cell and β is the local slope. The value represents the drainage capacity of a 
given cell; a cell with a higher soil moisture content is more prone to saturation and thus 
may play a greater role in surface runoff. A higher cell value indicates a higher moisture 
content.  
The resulted new TWI raster shows a remarkable spatial distribution of those areas that 
are affected by potentially increased soil moisture content (Figure 137). It also means 
that the overland flow concentrations are mainly pass through these areas in general. This 
dataset can help highlighting some local land use risks related to the vineyard farming 
practices that should be investigated in detail. The more wet areas can experience 
increased rates of soil loss that can resulted in rill and gully erosion processes which is a 
harmful consequence of the rainfall activities. On the other hand, we mainly identify 
these areas running parallel to the main grape stock lines, therefore, this wetness is 
concentrated between their rows. The opposite land elements colored in reddish are 
mainly associated with the dense vegetation patches that we were not able to eliminate 
during the CANUPO classification and filtering. However, in general, we can even accept 
that argument as well that these densely vegetated land features are usually split the main 
runoff into several subsets due to the roots and canopy; therefore, even an accurately 
removed vegetation point features could result in a similar hydrological wetness 
characterization.  
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Figure 137. Preview of the Topographic Wetness Index (TWI) results in SAGA 

In case we are interested in plotting these potentially wet areas, then we have the 
opportunity to export these rasters (not only the file of Topographic Wetness Index) in 
order to be opened in another GIS software like QGIS. You can do it easily by right 
clicking on the appropriate raster, then ‘Save as’. In the next pop-up window, I suggest 
to use the ‘GeoTIFF’ file format with the *.tiff file extension which is a quite widely used 
format which will be easy to handle and postprocess in almost any kind of GIS software 
environment. Once you have saved your Topographic Wetness Index as “TWI.tif” then 
you can open both the UAV-based orthomosaic and this new raster into QGIS (Figure 
138).  
 

 
Figure 138. Preview of the Topographic Wetness Index plotted on the UAV-based orthomosaic 

in QGIS 
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As you can see the TWI as a derivative from the preprocessed Digital Terrain Model has 
the same cartographic projection, therefore, it fits accurately to the UAV-based 
orthomosaic. However, we should select a much efficient symbology for our 
Topographic Wetness Index raster. In order to do this, double click on the TWI raster, 
then in the ‘Layer Properties’ window select the ‘Symbology’ tab. Now, select the 
‘Singleband pseudoco’or' type from the list of ‘Render type’ options. The following 
setting will be the selection of ‘Discrete’ from the ‘Interpolation’ types, then change the 
‘Mode’ from ‘Continous’ to ‘Quantile’. Finally, increase the ‘Classes’ from 5 to 10. Now, 
you can click on ‘Apply’ then ‘OK’ to view the new, improved visualization of the 
Topographic Wetness Index (Figure 139). 
 

 
Figure 139. The improved symbology of the Topographic Wetness Index in QGIS 

We are now able to see the raster value classes in the Layer manager tab. For a more 
effective overview of the areas having potentially increased soil moisture content we can 
do two more processing steps. First of all, double click again on the Topographic Wetness 
Index raster, then in the ‘Layer Properties’ window click on ‘Transparency’. In this stage 
you have the opportunity to decrease the ‘Global Opacity’ to for example 40% (Figure 
140).  
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Figure 140. The Topographic Wetness Index raster visualized with a decreased opacity in QGIS 

After looking the figure above, we can agree with the fact that now it is easy to 
qualitatively evaluate the spatial distribution of these characteristics, but we can do 
another step. The aim is to keep only those raster cells that refer to the highest 
Topographic Wetness Index values. In order to perform this, double click on the TWI 
raster and in the Symbology’ tab of the ‘Layer Properties’ window check the value 
classes. Right click on each class that you would like to ‘hide’ and click on ‘Change 
Opacity’. In the small pop-up window, decrease the color opacity to 0% (Figure 141). 
My recommendation is to keep plotted only the three classes having the highest 
Topographic Wetness Index values.  
 

 
Figure 141. Hiding the unnecessary raster classes in QGIS 
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Once you have performed this step, then you will notice that now the raster values are 
hardly visible, therefore, I suggest increasing back the layer transparency rate value to 
for example 80%. With this kind of settings, we are able to see a great overview of the 
local hydrological conditions regarding the potential overland flow characteristics. For 
example, on the top right corner within the red circle we are able to see a potential area 
where the flow can be concentrated, therefore, it could lead to a potential increase of the 
erosion of edge of the gully system. However, we can also identify a major issue 
regarding our dataset. At the middle of the orthomosaic we can see the gully erosion 
trench from northeastern to southwestern direction, that is accompanied by dense 
vegetation patches on the top edge (Figure 142). This linear landform also has a dark 
colorization due to the shadow effects. This effect also resulted in an incorrect elevation 
reconstruction which means that the final DTM does not provide the appropriate relief 
structure. It means also that the potential overland flow directions are also derived with 
errors. That is what we can observe at the area in the middle within the other red circle. 
This gully erosion trench is characterized by 3- to 5-meters-deep walls, therefore, it is 
hardly possible that the intensive overland flow path will be concentrated and heading to 
the northwestern part of the area.  
 

 
Figure 142. The highest three raster value classes based on Topographic Wetness Index in 

QGIS 

In order to verify this possible issue, I suggest now to visualize the drainage network of 
the study area calculated by the Basic Terrain Analysis in SAGA.  
However, before working with the Drainage networks, we have to understand how we 
can derive the routes and directions of the overland flows. We need to calculate first the 
flow directions: the flow direction is in principle defined by the exposure. In DTM, 
however, a cell has only 8 neighbors, corresponding to k*45° directions. However, in 
principle, the exposure is defined by can take any value. Therefore, there are several 
possibilities to determine the direction of the runoff, three of which are briefly described 
(Figure 143): 
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1. D8 method: the cell with the maximum downward gradient is selected. This is 
obtained by dividing the difference in level with respect to the central cell by the 
distance from the central cell. The distance is equal to the resolution in axial 
directions and √2 times greater in diagonal directions. The point is that the run-off 
water is then directed in its entirety, i.e., deterministically, to a single other cell, 
hence the name of the method (Deterministic 8; 8 refers to the number of 
neighboring cells). The disadvantage of the method is that the runoff paths consist 
of only sections corresponding to multiples of 45°. With good resolution this is 
less troublesome, but it is simple to method and is therefore the most widely used. 

2. D∞ method (Tarboton): this is a multi-directional runoff method. The runoff is 
distributed between the 2 cells closest to the direction of the exposure vector. The 
distribution of water is proportional to the proximity of each cell to the exposure 
vector. The ∞ sign indicates the infinite possible direction of the exposure vector. 

3. MD (Multiple direction) method (Freeman): this method sends water to all lower 
neighboring cells. The distribution is proportional to the power p of the slope. The 
value of P is arbitrary and has no physical content, a value of around 1.1 is usually 
recommended. The disadvantage of this method is that the dispersion may be too 
large, so that runoff paths are not well plotted. However, a flood situation can be 
relatively well characterized by this method. 

 

 
Figure 143. The concept of the different flow routing methods 

(Source: Internet 2) 

The model of the drainage network (channel network) can be generalized by thresholding 
the values of the catchment areas per cell and allows further simple investigations, e.g., 
determination of the elevation above the network, or the difference in elevation between 
a given point in the network and the base of the catchment, valley length calculation.  
The SAGA Basic Terrain Analysis tool has already generated the channel network that 
we can visualize in the SAGA window, but it can be also exported into a shapefile by 
right clicking the layer and ‘Save as’ as an ESRI Shape File.  
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Figure 144. Preview of the calculated drainage network in SAGA 

Once we have added this new vector layer into the previous map composition in QGIS, 
then we will see more obviously the errors of our dataset (Figure 144). In this figure also 
clearly visible that the main channel was split into two reaches while the main flow is 
headed towards the northeastern slopes, which is impossible. 
 

 
Figure 145. Incorrect drainage network generated for the study area 

The solution is associated with the errors of the photogrammetric surface reconstruction 
method. No, we can acknowledge that the UAV-based Digital Terrain Model, that we 
have used for the Basic Terrain Analysis tool in SAGA was not correct in the sense of 
the elevation values along the gully system as a result of shadow effects. We can easily 
overcome this situation if we perform an additional data curation on the Digital Terrain 
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Model. Based on the high-resolution UAV-based orthomosaic we can accurately draw 
the extent of the linear gully system. If we then tell the GIS system to decrease the raster 
values within this area, then we will be able to force the dataset to have the lowest 
elevation values situated inside the gully system. It will lead to a correct hydrological 
characterization. 
In order to perform the above-mentioned processing, we should create a new polygon 
shapefile in QGIS by clicking on the ‘Layer’ menu, then Create Layer > New Shapefile 
Layer (Figure 146). It is really important to select the ‘Polygon’ Geometry type.  
 

 
Figure 146. Creation of the new polygon shapefile in QGIS 

Finally, we should choose the appropriate coordinate reference system identical to the 
orthomosaic and the Digital Terrain Model of the study area. We can now click on ‘OK’. 
Now the new shapefile appears in the list of Layers, however, it is completely empty at 
the moment. It is our turn now to create the polygon of the entire gully system. We should 
first click on ‘Toggle Editing’ in the ‘Layer’ menu. Then we should use the ‘Add Polygon 
Feature’ tool for the digitalization of the gully borders (Figure 147).  
 

 
Figure 147. The tool used for creating the gully border polygon in QGIS 

We can carefully click and place the vector vertices along the gully edge in order to 
establish the necessary polygon for our needs. Once we have finished, stop the editing 
mode and save all our progress (Figure 148-149).  
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Figure 148. The vectorized polygon of the gully system in QGIS 

As a first step, we have to cut out this area from the Digital Terrain Model surrounded by 
this polygon. This process can be easily done in QGIS toolkits. First, load the shape file 
that we have created in the previous step.  
 

 
Figure 149. The extent of the user-defined gully system polygon on the DTM in QGIS 

The next step is to use the grid clipping tool of QGIS by clicking to ‘Raster’ > ‘Extraction’ 
> ‘Clip Raster by Mask Layer…’. The ‘Input Layer’ must be our original Digital Terrain 
Model while the ‘Mask Layer’ must be the recently vectorized gully border polygon. The 
extraction result will be a single raster clipped within the gully borders (Figure 150). 
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Figure 150. Preview of the DTM subset clipped by the gully border in QGIS 

The next step will be to decrease the elevation values of this raster significantly. We 
should open the ‘Raster’ menu > ‘Raster Calculator’ (Figure 151). Our aim now is to 
decrease the elevation of each single raster pixel by for example, 10 meters. In order to 
perform this, we should first double click on the appropriate raster layer of the new gully 
DTM. It will appear now in the ‘Raster Calculator Expression’ tab. Now we should 
simply click on the numerical operation of ‘minus’ then type number 10. If we proceed 
correctly like in the figure below then an acknowledgement message will appear stating 
that the “Expression valid”. I suggest saving the Output layer into a new GeoTIFF file in 
the ‘Result Layer’ tab like giving a new name of “dtm_minus.tif” and hit OK. 
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Figure 151. The Raster Calculator tool in QGIS 

The resulting raster will have the same extent and grid system but each single pixel values 
are now 10 meters lower. Now, we should merge this small raster subset with the original 
Digital Terrain Model in order to replace their pixel values with this recently decreased 
gully area. The necessary tool can be found in the Processing Toolbox of QGIS. The 
toolbox itself can be hidden at the default installation. In such cases you can activate it 
by clicking on the ‘View’ menu and then ‘Panels’ tab and put a tick mark ahead of the 
‘Processing Toolbox’. The toolbox now appears at the right side of the QGIS window. 
At the top of its tab, you can find a ‘Search’ feature where you can quickly browse within 
the available toolkits by typing the appropriate keywords. You should now type in the 
term ‘Mosaic’ when the necessary tool will appear. However, we have installed a 
standalone version of SAGA GIS to our computer but a minor set of tools from SAGA is 
also installed in the QGIS software as well. That is the reason why SAGA appears also 
in the list of tools in the Processing Toolbox. You will need now the ‘Mosaic raster layers’ 
tool from SAGA Raster tools (Figure 152).  
 

 
Figure 152. The Mosaic tool in the Processing Toolbox of QGIS 
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You should now select the two raster grids that you are intended to merge: 1) the original 
raster DTM and 2) the recently clipped subset based on the vectorized polygon (Figure 
153). You can specify a name for this new joint raster grid at the ‘Name’ field. However, 
I suggest leaving the majority of settings as default, but it is important to set up the same 
‘Cellsize’ of the original DTM. That value is 0.2 (meters) in our case. Furthermore, the 
new DTM raster should fit accurately to the original one; thus, we have to choose the ‘[1] 
cells’ option from the ‘Fit’ types. 
 

 
Figure 153. The Raster layer mosaicking tool in QGIS 

The results of the procedure will be clearly identifiable in terms of the main differences. 
As you can see on Figure 154 the new DTM raster has now more significant elevation 
differences along the trenches of the gully system. 
 

 
Figure 154. The original DTM (left) and the DTM after merging the ‘lowered’ gully subset 

(right) in QGIS 
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In these circumstances, the digital representation of the geomorphological setting is more 
comparable to the real conditions. Therefore, we can run again the processing of the DTM 
in the SAGA module in order to reveal the main differences in the Topographic Wetness 
Index and the Drainage network. 
 

 
Figure 155. The spatial differences in the highest Topographic Wetness Index values based on 

the calculations of the original (A) and the corrected (B) DTMs 
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What we can observe on Figure 156 is that we were able to correct the misleading wetness 
concentration that was identified as a northeastern direction in the middle of the western 
vineyard plot. Consequently, our ‘trick’ by decreasing the gully trench elevation values 
have resulted in the proper way.  
Another proof of our successful data correction can be also revealed by checking the 
updated polylines of the drainage network. In the recent version, the above-mentioned 
‘channel’ connection had been eliminated. The minor linear overland flow features are 
now originated from the top edge of the gully trench. This is the way how the process 
could be evolve in natural circumstances.  
 

 
Figure 156. The spatial differences between the delineated drainage networks based on the 

calculations of the original (A) and the corrected (B) DTMs 

 
 



        

106 
 

Delineation of catchment basins 
From the runoff network, the area of the catchment basins associated with each 
watercourse can be determined, and from the runoff network and slope angles, the length 
of the watercourse, the length of the catchment, interpreted as the distance from the 
highest point to the discharge point, can be modelled. The drainage network is the basis 
for the stream ordering (Strahler, Shreve), and also for the calculation of the valley 
density characterizing the valley network pattern.  
According to the results of SAGA, we can distinguish the following catchments, basins 
(Figure 157). We can easily save our drainage basin polygons as shape files, then we 
 

 
Figure 157. The drainage basins calculated for the study area based on the corrected DTM 

Stream order 
For characterizing the size of rivers and thus for classification, the different stream 
orderings are also useful. The stream order definition is essentially part of the 
morphometric analysis of a watercourse. There are several approaches to the 
determination of stream order of which Strahler-based and Shreve-based are commonly 
used, with similar principles but different numerical results in their specific application. 
Strahler defined the headwater reaches of river flows, i.e., the reaches from the source to 
the first confluence, as first order (u1). The junction of two first-order branches gives rise 
to a second order (u2) watercourse. In general: the confluence of watercourses of the 
same order (un) increases the order number by one. However, there is no increase in the 
number of rivers when rivers with different numbers meet. The order of the river system 
is thus finally equal to the order reached at the mouth of the main river. 
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Later, Horton modified Strahler's system because it does not distinguish between main 
rivers, which can be a problem in the case of extended catchments. The disadvantage of 
Horton's system, however, is that it assumes that Strahler's ordinals have already been 
determined. A further problem is that it is difficult to distinguish between true first-order 
reaches and extensions of higher-order reaches, i.e., the Strahler system is not obsolete, 
especially in the context that although the order can be determined visually on paper, a 
faster and more objective form of determining order is to do it in a GIS system 
environment. 
Shreve's approach differs from the Strahler/Horton system in that the intersection of river 
branches always increases the ordinate. In other words, not only does the confluence of 
branches with the same ordinal number increase the ordinal number, and not only by one, 
but the meeting of all branches increases the ordinal number by a simple addition of the 
ordinal numbers of the branches that meet. 
Thus, the order depends essentially on the number of river encounters, although not all 
encounters are order-increasing. Strahler's system is used more in geomorphology, 
Shreve's approach more in hydrodynamics. In fact, the two numbers together properly 
characterize a watercourse: while Strahler's gives information on how symmetrical it is 
(a higher number indicates this, while a low order value indicates that tributaries of 
different order numbers have met), Shreve's method counts all tributaries together. 
Together, the two values give information about the catchment. In Strahler's method, in 
general, longer rivers and rivers with larger catchments have a higher order, but as Figure 
1 shows, this is not necessarily the case, as the meeting of rivers with different orders 
does not increase the order. Therefore, order can be counted separately (as a separate 
factor) from the previous characteristics (length, catchment area) when classifying 
watercourses.  
 

 
Figure 158. Different type of stream orders  

(Source: Internet 4) 

At the river section level, not only upstream stage stream order is an important measure, 
but also downstream stage stream order. That is, the downstream number gives an 
indication of the location of the reach in the basin/watershed, e.g., whether, although the 
stream is smaller, a larger river is expected downstream. 
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The Basic Terrain Analysis tool of SAGA generally calculates the stream order values 
for each river drainage/channel network segment based on the Strahler method. Once we 
export these polylines and overlay them on the hillshade model of the study area DTM, 
then we can do an additional processing step to visualize the dominant drainage network. 
In the ‘Symbology’ settings you can select the ‘Categorized’ type, the choose the ‘Order’ 
value for the visualization. In case you delete the first to entries (having stream orders 1 
and 2) from the list, then you will have the major drainage. I also suggest to increase the 
size of each segments by the increasing stream order values to get a more sophisticated 
overview. 
 

 
Figure 159. Settings of the polyline categorization for stream order visualization in QGIS 

 
Figure 160. The drainage network of the study area based on the highest stream order values 

(Strahler method)  
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Chapter 3. Geostatistics in Practice 

1 Some thoughts on geostatistics 
It is not an easy task to define geostatistics, especially if we take into consideration that 
geostatistical concepts and tools have been widely used in numerous fields studying 
spatial or spatio-temporal phenomena quantitatively. In the golden age of geostatistics 
(about the 1960s), it was defined as “concerning with the study of the distribution in space 
of useful values for mining engineers and geologists, such as grade, thickness or 
accumulation, including the most important practical application to the problems arising 
in ore-deposit evaluation” (Matheron, 1963), or much simpler, “the application of the 
theory of regionalized variables to the estimation of mineral deposits (with all that this 
implies)” (Matheron, 1971). Clearly, the definitions above are somewhat strict or perhaps 
even inappropriate in our days in the sense that geostatistics is definitely not only for the 
quantitative evaluation of mineral deposits. Nowadays, geostatistics is much more 
generally used in various fields, such as soil science, hydrogeology, geochemistry, 
environmental sciences, ecology, physical geography, just to name a few, for analyzing, 
interpreting and modelling spatial or spatio-temporal phenomena. Therefore, 
geostatistics calls for a more general definition, for example, “geostatistics provides a set 
of statistical tools for incorporating the spatial and temporal coordinates of observations 
in data processing” (Goovaerts, 1997), or “it aims at providing quantitative descriptions 
of natural variables distributed in space or in time and space” (Chilés and Delfiner, 
2012). The bottom line is that geostatistics is for anyone who wants to study spatial or 
spatio-temporal phenomena quantitatively. 

1.1 Insufficiency of classical statistical concepts 
It is worth starting with a question: Why is it better to use geostatistics instead of classical 
statistics when a spatial phenomenon is studied quantitatively? We shall take the 
histogram as an example, which is one of the most frequently used graphical data-
representation techniques in classical statistics. The histogram graphically shows the 
frequency of the data values falling in classes with equal width and provides important 
information about the empirical distribution of the data. However, it does not take the 
geographical location of the data into account, which is as important as the data values 
themselves in many spatially referenced studies. This can be attributed to the fact that 
classical statistics regards the spatial phenomenon under study as a random variable. A 
random variable is a variable that is itself a function of the result of a statistical 
experiment in which each outcome has a definite probability of occurrence. 

There are two essential properties of the random variables, which strongly relate to their 
notion. The first one is that an experiment that assigns a numerical value to a random 
variable can be repeated infinitely many times in theory or any number of times in 
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practice. For example, an experiment may be throwing the dice, coin flipping (or coin 
tossing), measuring the organic carbon content of sediments or measuring the aggregate 
stability of a soil sample. It is easy to see that in the first two cases we can repeat the 
experiment as many times as we want; there is no limit in theory. However, in the last 
two cases, we can hardly imagine the same because there are a plenty of laboratory or 
field measurement techniques, including organic carbon measurement or aggregate 
stability analysis that simply destroy the sample during the measuring process; this is also 
part of the measurement. It is not possible to measure, for example, the organic carbon 
content of the same sample again because the sample has been already destroyed by wet 
combustion or loss on ignition. Clearly, we can create some replicates but only a few 
ones, and we also have to see that they are not the same in point of the experiment. The 
second property of the random variables is that the results (or outcomes) of an experiment 
are independent of each other. It is easy to see that in the cases of throwing the dice or 
coin flipping this works actually. For example, flipping “heads” does not predestinate 
that next flipping will yield “heads” again but there is an equivalent chance to get either 
“heads” or “tails”. Furthermore, throwing “5” does not predestinate that next throwing 
will yield “5” or such a high value again. Next throwing has equally chance to be “1”, 
“2”, “3”, “4”, “5” or even “6”. However, when a spatial phenomenon is studied, we 
frequently observe that there is a relationship between data close to each other; we 
frequently say, “there is a correlation between the data”. For example, we frequently find 
that soil pH is more similar between two sampling points taken a few meters apart than 
between samples taken hundreds of meters apart. This completely refutes the 
independency of the outcomes of an experiment and, consequently, it is not so lucky to 
regard a spatial phenomenon as a random variable all the time. Instead, it is worthy of 
explicitly taking into consideration the geographical location of the data and the 
correlation between them when some kind of spatial inferences are made on the spatial 
phenomenon under study. 

1.2 Notion of regionalized variables 
Mining engineers and geologists had early recognized the facts mentioned above and 
seen that classical statistics is not able to take the spatial aspect of the data into account, 
although it is as important as the data values themselves. Therefore, an approach was 
needed that is able to explicitly take into consideration the spatiality that is one of the 
most important attributes of the spatial phenomenon under study. Thanks to Danie Krige 
(1919-2013) and Georges Matheron (1930-2000), the theory of regionalized variables 
was published in the 1960s, which summarized the principles of geostatistics (Matheron, 
1963). 

After Georges Matheron, a regionalized variable is approached by a random function, 
where a random function is a set of random variables whose dependence on each other is 
specified by some probabilistic mechanism. The regionalized variable representing the 
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phenomenon (the set of all of its possible values distributed in space) is considered as a 
particular realization of the random function constructed on this phenomenon (the set of 
an infinity of random variables representing the values of the phenomenon at each point 
in space) (Pannatier, 1996). A regionalized variables usually shows a structured aspect 
and an erratic aspect. The structured aspect is related to the overall distribution of the 
spatial phenomenon and each data point is related by a correlation expressing the spatial 
structure (or spatial continuity) of the phenomenon, whereas the erratic aspect is related 
to the local behavior of the spatial phenomenon and a data point is considered as a random 
variable (Pannatier, 1996). Based on these it can be said that the main difference between 
geostatistics and classical statistics is in the recording and extension of information from 
the data points related to the phenomenon. While classical statistics considers the 
phenomenon as a random variable and the data are independent, geostatistics considers 
it as a regionalized variable and the data are not independent of each other. 

1.3 Assumptions made on stationarity 
As we have already pointed out above, geostatistics assumes that the phenomenon under 
study can be modelled as a spatial or spatio-temporal stochastic process. Another 
frequently used assumption is stationarity, which is often misunderstood. Data points are 
available for the phenomenon under study, but more repeated measurements would be 
needed for the computations. As mentioned above, it is not possible. Nevertheless, if the 
phenomenon under study can be considered homogeneous in the area of interest, then its 
data point values can be considered as a repetition of the regionalized variable in space. 
This repetition gives the identity of many realizations of the same random function and 
allows statistical computations. The assumptions made on stationarity is associated with 
different degrees of spatial homogeneity of the phenomenon under study. The following 
types of stationarity are the most frequently used in practice (Myers, 1989): 

- Weak (or second order) stationarity: A random function holds weak stationarity 
if the expected value exists and does not depend on the location, furthermore, the 
covariance exists and depends only on the separation vector separating the data 
points. 

- Intrinsic hypothesis: A random function holds intrinsic hypothesis if the expected 
value does not depend on the location, furthermore, the semivariogram exists and 
depends only on the separation vector separating the data points. We should note 
that intrinsic hypothesis is in fact weak stationarity restricted to the increments 
of the random function. 

Spatial inference that can be made within the framework of the probability model 
depends on the type of stationarity. It is important to emphasize that stationarity is an 
attribute of the random function and definitely not a property of the data or of reality 
(Szatmári and Pásztor, 2016). Therefore, a question like “is the spatial phenomenon 
under study stationary?” does not make too much sense. However, a question like “is 
the stationary probability model constructed for the spatial phenomenon under study 
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realistic?” makes much more sense; it can be answered in the light of the purpose of the 
modelling. It is important to highlight that there is no test for the choice of the type of 
stationarity, these assumptions or hypotheses cannot be confirmed by the sample usually. 
Therefore, the assumption made on stationarity is not a true hypothesis - rather a decision 
of the expert or practitioner - since it can neither be accepted nor rejected on the basis of 
the data. This also implies that when developing a sampling strategy, it is important to 
develop a situation that makes the stationarity assumptions obvious (Füst and Geiger, 
2010). 

2 Preparing R for geostatistical computations 
Although the R language and software environment (R Core Team, 2021) is an excellent 
tool for performing statistical analysis and presenting results graphically, its basic 
packages do not support either spatial analysis or geostatistical computations. It is 
therefore necessary to install packages that allow us to perform such analysis and 
computations. In this chapter, the following R packages will be used for that: “gstat”, 
“sp”, “rgdal”, and “raster”. We shall install them - except those ones that have already 
been installed earlier: 

list.of.packages <- c("sp", "gstat", "rgdal", "raster") # List of the packages 
we shall use in this chapter 
new.packages <- list.of.packages[!(list.of.packages %in% installed.packages()[
,"Package"])] # Select the packages that have not yet been installed 
if(length(new.packages)) install.packages(new.packages) # Install new packages 

Note that we only need to install the packages the first time. Once the packages have been 
installed, they need to be loaded and attached in order to use them and the functions they 
contain. It can be readily done by the function “library”: 

library(sp) 
library(gstat) 
library(rgdal) 
library(raster) 

Note that all the packages must be loaded each time a new R session is started. Now R is 
ready for performing geostatistical analyses and computations. 

3 The Meuse data set 
The Meuse data set contained in the R package “sp” is a data base comprising four heavy 
metals (i.e., cadmium, copper, lead, and zinc) and a soil property (i.e., organic matter 
content) measured in the topsoil in a flood plain along the Meuse River (the Netherlands). 
The units of heavy metals and organic matter content are [ppm] and [wt. %], respectively. 
The data set comprises 155 samples with the measured attributes listed above. For more 
information on the data set see the link below. The process governing heavy metal 
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distribution seems that polluted sediment is carried by the river, and mostly deposited 
close to the riverbank, and areas with low elevation. Note that the data set is of class 
“data.frame”. Therefore, we shall set the spatial coordinates to create a “Spatial” object 
and then plot some heavy metals' map (Figure 161): 

https://www.rdocumentation.org/packages/sp/versions/1.4-5/topics/meuse 

 
Figure 161. Spatial distribution of heavy metals contained in the Meuse data set. 

data(meuse) # Load the Meuse data set 
str(meuse) # Take a look at the structure of the data set 

## 'data.frame':    155 obs. of  14 variables: 
##  $ x      : num  181072 181025 181165 181298 181307 ... 
##  $ y      : num  333611 333558 333537 333484 333330 ... 
##  $ cadmium: num  11.7 8.6 6.5 2.6 2.8 3 3.2 2.8 2.4 1.6 ... 
##  $ copper : num  85 81 68 81 48 61 31 29 37 24 ... 
##  $ lead   : num  299 277 199 116 117 137 132 150 133 80 ... 
##  $ zinc   : num  1022 1141 640 257 269 ... 
##  $ elev   : num  7.91 6.98 7.8 7.66 7.48 ... 
##  $ dist   : num  0.00136 0.01222 0.10303 0.19009 0.27709 ... 
##  $ om     : num  13.6 14 13 8 8.7 7.8 9.2 9.5 10.6 6.3 ... 
##  $ ffreq  : Factor w/ 3 levels "1","2","3": 1 1 1 1 1 1 1 1 1 1 ... 
##  $ soil   : Factor w/ 3 levels "1","2","3": 1 1 1 2 2 2 2 1 1 2 ... 
##  $ lime   : Factor w/ 2 levels "0","1": 2 2 2 1 1 1 1 1 1 1 ... 
##  $ landuse: Factor w/ 15 levels "Aa","Ab","Ag",..: 4 4 4 11 4 11 4 2 2 15 .
.. 
##  $ dist.m : num  50 30 150 270 380 470 240 120 240 420 ... 

coordinates(meuse) <- ~x+y # Set spatial coordinates 
plot01 <- spplot(meuse["zinc"], main="Zinc [ppm]") # Spatial distribution of z
inc observations 
plot02 <- spplot(meuse["copper"], main="Copper [ppm]") # Spatial distribution 
of copper observations 
plot03 <- spplot(meuse["cadmium"], main="Cadmium [ppm]") # Spatial distributio
n of cadmium observations 
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print(plot01, split=c(1,1,3,1), more=TRUE) 
print(plot02, split=c(2,1,3,1), more=TRUE) 
print(plot03, split=c(3,1,3,1), more=FALSE) # Plot maps next to each other 

Now, the Meuse data set is already a “Spatial” object (to be more precise it is an object 
of class “SpatialPointsDataFrame”) and ready for spatial analyses and geostatistical 
computations. We shall take a look at some descriptive statistics of the data set by using 
the basic function “summary” and then compute the variance of some heavy metals (e.g., 
zinc, copper, and cadmium) by the basic function “var”: 

summary(meuse) # Give a summary on the data set 

## Object of class SpatialPointsDataFrame 
## Coordinates: 
##      min    max 
## x 178605 181390 
## y 329714 333611 
## Is projected: NA  
## proj4string : [NA] 
## Number of points: 155 
## Data attributes: 
##     cadmium           copper            lead            zinc        
##  Min.   : 0.200   Min.   : 14.00   Min.   : 37.0   Min.   : 113.0   
##  1st Qu.: 0.800   1st Qu.: 23.00   1st Qu.: 72.5   1st Qu.: 198.0   
##  Median : 2.100   Median : 31.00   Median :123.0   Median : 326.0   
##  Mean   : 3.246   Mean   : 40.32   Mean   :153.4   Mean   : 469.7   
##  3rd Qu.: 3.850   3rd Qu.: 49.50   3rd Qu.:207.0   3rd Qu.: 674.5   
##  Max.   :18.100   Max.   :128.00   Max.   :654.0   Max.   :1839.0   
##                                                                     
##       elev             dist               om         ffreq  soil   lime    
##  Min.   : 5.180   Min.   :0.00000   Min.   : 1.000   1:84   1:97   0:111   
##  1st Qu.: 7.546   1st Qu.:0.07569   1st Qu.: 5.300   2:48   2:46   1: 44   
##  Median : 8.180   Median :0.21184   Median : 6.900   3:23   3:12           
##  Mean   : 8.165   Mean   :0.24002   Mean   : 7.478                         
##  3rd Qu.: 8.955   3rd Qu.:0.36407   3rd Qu.: 9.000                         
##  Max.   :10.520   Max.   :0.88039   Max.   :17.000                         
##                                     NA's   :2                              
##     landuse       dist.m       
##  W      :50   Min.   :  10.0   
##  Ah     :39   1st Qu.:  80.0   
##  Am     :22   Median : 270.0   
##  Fw     :10   Mean   : 290.3   
##  Ab     : 8   3rd Qu.: 450.0   
##  (Other):25   Max.   :1000.0   
##  NA's   : 1 

var(meuse$zinc); var(meuse$copper); var(meuse$cadmium) # Compute the variance 
of some heavy metals 

## [1] 134743.2 # Variance of zinc data 

## [1] 560.763 # Variance of copper data 

## [1] 12.41678 # Variance of cadmium data 
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We can see that the function “summary” gives not just a short descriptive statistics (i.e., 
mean, median, minimum, maximum, 1st and 3rd quartile) on the data contained in the 
“Spatial” object but also provide information on the bounding box of the object (i.e., 
minimum and maximum value for the coordinates x and y), the coordinate reference 
system if it is defined (in our case it is missing), and the number of data points in the data 
set (i.e., 155). 

The R package “sp” also contains a raster stack for the Meuse data set. Note that the raster 
stack is of class “data.frame” too. Therefore, we shall set spatial coordinates to create a 
“Spatial” object as it was also done above: 

data(meuse.grid) # Load the meuse raster data 
coordinates(meuse.grid) <- ~x+y # Set spatial coordinates 
gridded(meuse.grid)=TRUE # Create a grid 
str(meuse.grid) # Take a look at its structure 

## Formal class 'SpatialPixelsDataFrame' [package "sp"] with 7 slots 
##   ..@ data       :'data.frame':  3103 obs. of  5 variables: 
##   .. ..$ part.a: num [1:3103] 1 1 1 1 1 1 1 1 1 1 ... 
##   .. ..$ part.b: num [1:3103] 0 0 0 0 0 0 0 0 0 0 ... 
##   .. ..$ dist  : num [1:3103] 0 0 0.0122 0.0435 0 ... 
##   .. ..$ soil  : Factor w/ 3 levels "1","2","3": 1 1 1 1 1 1 1 1 1 1 ... 
##   .. ..$ ffreq : Factor w/ 3 levels "1","2","3": 1 1 1 1 1 1 1 1 1 1 ... 
##   ..@ coords.nrs : num(0)  
##   ..@ grid       :Formal class 'GridTopology' [package "sp"] with 3 slots 
##   .. .. ..@ cellcentre.offset: Named num [1:2] 178460 329620 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   .. .. ..@ cellsize         : Named num [1:2] 40 40 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   .. .. ..@ cells.dim        : Named int [1:2] 78 104 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   ..@ grid.index : int [1:3103] 69 146 147 148 223 224 225 226 300 301 ... 
##   ..@ coords     : num [1:3103, 1:2] 181180 181140 181180 181220 181100 ... 
##   .. ..- attr(*, "dimnames")=List of 2 
##   .. .. ..$ : chr [1:3103] "1" "2" "3" "4" ... 
##   .. .. ..$ : chr [1:2] "x" "y" 
##   ..@ bbox       : num [1:2, 1:2] 178440 329600 181560 333760 
##   .. ..- attr(*, "dimnames")=List of 2 
##   .. .. ..$ : chr [1:2] "x" "y" 
##   .. .. ..$ : chr [1:2] "min" "max" 
##   ..@ proj4string:Formal class 'CRS' [package "sp"] with 1 slot 
##   .. .. ..@ projargs: chr NA 

In the upcoming sections, we shall perform geostatistical analysis and computations on 
the Meuse data set loaded above. 
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4 Variography 
The variogram is the most frequently used measure for describing the spatial variability 
(or spatial continuity) of the phenomenon under study. However, we should note that its 
computation, interpretation and modelling are often performed hastily or poorly, or even 
completely neglected in the course of spatial data analysis. As a matter of fact, it is a 
serious mistake as the variogram is a critical input of any geostatistical studies because 
(i) using the variogram we can investigate and quantify the spatial variability of the 
phenomenon under study, (ii) most geostatistical techniques (including estimation and 
simulation algorithms) require an analytical variogram model, and (iii) the variogram 
reflects some of our understanding of the geometry and continuity of the spatial 
phenomenon and therefore can have an important effect on the results of the final 
geostatistical model (Gringarten and Deutsch, 2001). Therefore, special attention should 
be paid to the computation, interpretation and modelling of the variogram when 
geostatistical modelling is targeted. 

4.1 H-scatterplots 
Before dealing with the variogram in details, we first check graphically how the zinc data 
of the Meuse data set separated by different separation vectors (e.g., 0, 80, 120, 250, 500, 
1000, and 1500 m) vary over the study area. This can be easily done by the function 
“hscat” of the R package “gstat”: 

hscat(formula=zinc~1, data=meuse, breaks=c(0, 80, 120, 250, 500, 1000, 1500)) 
# Create h-scatterplots 

 
Figure 162. H-scatterplots computed for the zinc concentration at various separation distances 

(i.e., 0, 80, 120, 250, 500, 1000, and 1500 m). 
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These plots (Figure 162) are known in geostatistics as h-scatterplots and such a graph 
shows the relationship between data points separated by a given separation vector in the 
geographical space. The h-scatterplots above show that there is an apparent dependency 
between the zinc data over the study area. In addition, we can also see that the larger the 
separation vector, the weaker the relationship between the zinc data, which is frequently 
expressed by the computed correlation coefficient (“r” values on the graphs). Based on 
the graphs we can also observe that there is practically no correlation between the zinc 
data for a separation vector larger than 1000 m. Also note that the point clouds take 
“butterfly” shape (especially in the last row in Figure 162), which indicates that the zinc 
data are lognormally distributed and have to be transformed to the normal scale before 
conducting variography on them. 

4.2 Experimental variogram 
In practice, geostatistics commonly uses the variogram instead of the covariance for 
describing and modelling the spatial variability mainly due to historical reasons, which 
can be attributed to the fact that the variogram is the own notion of geostatistics. It has 
negligible practical consequences as in the case of a random function with weak (or 
second-order) stationarity the variogram and covariance are equivalent tools in 
characterizing spatial continuity because 

 2𝛾(𝐡) = Var[𝑍(𝐮) − 𝑍(𝐮 + 𝐡)] = E[(𝑍(𝐮) − 𝑍(𝐮 + 𝐡)) ] (1) 

 𝐶(𝐡) = E[𝑍(𝐮) ∗ 𝑍(𝐮 + 𝐡)] − E[𝑍(𝐮)] ∗ 𝐸[𝑍(𝐮 + 𝐡)] (2) 

 𝛾(𝐡) = 𝐶(0) − 𝐶(𝐡) (3) 

 𝐶(𝐡) = 𝐶(0) − 𝛾(𝐡) (4) 

where γ(h) is the variogram, C(0) is the a priori variance (i.e., the variance of the data in 
practice), C(h) is the covariance, h is the separation vector, Z(u) and Z(u+h) are the 
random variables at location u and u+h, respectively, and E[.] and Var[.] stand for 
expectation and variance, respectively. However, we should note that in case of a random 
function with intrinsic hypothesis the equality above (Eq. 3 and 4) is not true. In such a 
case, only the variogram exists and only the variogram can be used to characterize spatial 
continuity. We also should highlight that systematic change in the mean of the 
observations (i.e., trend or drift) refutes even the weakest type of stationarity (i.e., 
intrinsic hypothesis). That usually appears as monotonic increase of the computed 
variogram. In such a case, we should remove the trend and then perform exploratory 
variography on the derived residuals. The most commonly used formula for estimating 
the variogram is Matheron’s (1963) method-of-moments estimator that is 
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𝛾(𝐡) =

1

2𝑁(𝐡)
[𝑧(𝐮 ) − 𝑧(𝐮 + 𝐡)]

(𝐡)

 (5) 

where γ(h) is the variogram, h is the separation vector, z(ui) and z(ui+h) are the observed 
value at location ui and ui+h, respectively, and N(h) is the number of data-pairs separated 
by the vector h. Using the function “variogram” of the R package “gstat”, we can compute 
the experimental variogram of the zinc data over the study area: 

v.zn <- variogram(log(zinc)~1, meuse) # Compute the experimental variogram of 
log-transformed zinc data 
plot(v.zn, main="Variogram of zinc data") # Plot the experimental variogram 

 
Figure 163. Experimental variogram computed for the zinc concentration. 

We should note that the experimental variogram above (Figure 163) is computed for the 
logarithmic transformed zinc data (“log(zinc)”) as we have observed that zinc data is 
lognormally distributed based on the h-scatterplots (see Figure 162). The computed 
experimental variogram has some descriptive features, which should be noted. The first 
one is the “sill” where the variogram flattens off. In the case of the zinc data, its value is 
about 0.65 (see Figure 163). The sill value is equal to the variance of the data used for 
variogram computation. The second one is the “range” within which the data points are 
correlated with each other. This also means that beyond the range there is no correlation 
between the data (to be more precise there is no positive correlation between them). 
Based on the h-scatterplots (Figure 162) we have already observed that zinc data are 
uncorrelated for a separation vector larger than 1000 m. The experimental variogram 
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computed above shows the same, i.e., the experimental variogram flattens off for a 
distance larger than 1000 m (see Figure 163), which can be identified as the range value 
in the case of zinc data. The third one is the “nugget” (or “nugget variance”), which is 
the discontinuity at the origin. The nugget variance can be attributed to two reasons: (i) 
short-scale variability that is shorter than the minimum distance between the data points, 
and/or (ii) measurement error. It is frequently compared to the sill by computing the 
“nugget to sill ratio”, which means the part of the variance of the data that cannot be 
modelled with linear geostatistics. The difference between the nugget and sill is 
commonly known as “partial sill”, which is the part of the variance that can be modelled 
with linear geostatistics. 

The experimental variogram of the zinc data (Figure 163) was computed with the default 
settings of the function “variogram”, which are mainly based on the size of the “Spatial” 
object’s bounding box. However, we can set different separation vectors to variogram 
computation by using the parameters “width” and “cutoff”: 

v.zn.2 <- variogram(log(zinc)~1, meuse, width=300, cutoff=1500) # Change the p
arameter "width" to 300 meter 
plot(v.zn.2, main="width = 300 m") # Plot the experimental variogram 

 
Figure 164. Experimental variogram computed for the zinc concentration (width=300 meter). 

v.zn.3 <- variogram(log(zinc)~1, meuse, width=25, cutoff=1500) # Change the pa
rameter "width" to 25 meter 
plot(v.zn.3, main="width = 25 m") # Plot the experimental variogram 
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Figure 165. Experimental variogram computed for the zinc concentration (width=25 meter). 

The parameter “width” is the distance of the separation vector, which is used to find data 
pairs for variogram computation. The parameter “cutoff” is the spatial separation distance 
up to which point pairs are included in variogram computation. Its default value is the 
length of the diagonal of the box spanning the data is divided by three. By adjusting these 
parameters (see Figure 164 and 165), we can more easily identify the shape and 
descriptive features of the variogram to be modelled in the next subsection. 

4.3 Variogram modelling 
Once we have computed the experimental variogram, the next step is to fit an analytical 
model, which is required by most geostatistical techniques (including estimation and 
simulation algorithms). For the sake of completeness, we should mention that only 
permissible models can be used to model the variogram, which ensures the positive 
definite condition. In practice, we commonly use so-called basic variogram models, 
which meet this condition. In the R package “gstat”, the function “vgm” is used to specify 
the variogram model to be fitted and support the following basic model types: 

vgm() # Show the basic model types in the R package „gstat” 

##    short                                      long 
## 1    Nug                              Nug (nugget) 
## 2    Exp                         Exp (exponential) 
## 3    Sph                           Sph (spherical) 
## 4    Gau                            Gau (gaussian) 
## 5    Exc        Exclass (Exponential class/stable) 
## 6    Mat                              Mat (Matern) 
## 7    Ste Mat (Matern, M. Stein's parameterization) 
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## 8    Cir                            Cir (circular) 
## 9    Lin                              Lin (linear) 
## 10   Bes                              Bes (bessel) 
## 11   Pen                      Pen (pentaspherical) 
## 12   Per                            Per (periodic) 
## 13   Wav                                Wav (wave) 
## 14   Hol                                Hol (hole) 
## 15   Log                         Log (logarithmic) 
## 16   Pow                               Pow (power) 
## 17   Spl                              Spl (spline) 
## 18   Leg                            Leg (Legendre) 
## 19   Err                   Err (Measurement error) 
## 20   Int                           Int (Intercept) 

In total, there are about 20 basic model types specified in the function “vgm”. In practice, 
however, we frequently use only a few ones such as “Exponential”, “Spherical”, 
“Gaussian”, “Linear” or “Nugget”: 

show.vgms(models = c("Exp", "Sph", "Gau", "Nug"), nugget=c(0.1, 0.25, 0.5, 1), 
range=c(1,1,1,0), sill = c(0.9,0.75,0.5,0)) # Plot some theoretical variogram 
models 

 
Figure 166. Some theoretical variogram models. 

In Figure 166, we can see that the plotted variogram models have been parametrized by 
the descriptive features (i.e., sill, range, and nugget) mentioned in the subsection above. 
Although these variogram models have almost the same values for the parameter sill, 
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range and nugget, their shapes are significantly different. For example, the “Spherical” 
model shows a quasi-linear function close to the origin, whereas the “Exponential” one 
shows an exponential function, which indicates that the correlation between the data is 
exponentially decreasing as the separation distance increasing. Note that the “Nugget” 
model is a specific model type, which is commonly used for (i) describing the 
discontinuity at the origin with zero range or (ii) for expressing the complete lack of 
correlation between the data in space (a case of little interest in practical geostatistics). 

Now, we shall try to fit a permissible analytical variogram model to the experimental 
variogram computed in the previous subsection (Figure 3). It is still a pending question 
in geostatistics how an analytical model should be fitted to an experimental variogram. 
There are geostatisticians who say that it is better to fit only by “eye” because the fitted 
variogram model is going to reflect all the expert knowledge about the spatial structure 
of the phenomenon under study. However, this approach relies on subjective decisions 
made by the expert or practitioner and can introduce even serious bias into further 
geostatistical modelling. Also, there are geostatisticians who strongly recommend that 
model fitting should be carried out by numerically and automatically without using any 
expert knowledge of the spatial phenomenon under study. Even if this approach provides 
a mathematically sound variogram model and there is no chance to introduce any bias 
from the decision of the practitioner, it is completely excluding the control and judgement 
of the expert or practitioner, which is not so lucky. The best practice may be between the 
two approaches. It is worthy of parametrizing the variogram model by “eye” and then 
fine-tuning its parameter values by a numerical method (Webster and Oliver, 2007). This 
golden mean approach is supported by the function “fit.variogram” of the R package 
“gstat”: 

vgm.zn <- fit.variogram(v.zn, vgm(psill=0.55, model="Sph", range=1000, nugget=
0.1)) # Fit a theoretical model to the experimental variogram 
vgm.zn # Show the fitted theoretical model 

##   model      psill    range 
## 1   Nug 0.05065905   0.0000 
## 2   Sph 0.59060445 896.9962 

plot(v.zn, vgm.zn, main="Experimental variogram and the fitted model (Zn)") # 
Plot the fitted model and the experimental variogram 

We used the values determined in the interpretation of the experimental variogram (see 
the previous subsection) as initial values for sill, range and nugget in model fitting. We 
should note that in the case of the function “fit.variogram”, not the sill but the partial sill 
(i.e., sill minus nugget) should be given. We can see that the fitted variogram model 
(Figure 167) has a so-called nested structure (i.e., it has more than one basic structure). 
The first structure is a “nugget” model describing the discontinuity at the origin with zero 
range (Figure 167). This part of the variance cannot be modelled with linear geostatistics. 
The second structure is a “spherical” one with a range value of about 900 m and a partial 
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sill value of about 0.6. Figure 167 shows both the fitted and the experimental variograms, 
and we can confirm that the model fits pretty well to the experimental variogram. The 
fitted variogram model can be used for further geostatistical computations. 

 
Figure 167. Experimental variogram computed for the zinc concentration (blue circles) and the 

fitted theoretical variogram model (solid blue line). 

4.4 Geometric anisotropy 
Although we talked about separation vectors in the previous subsections, we only used 
the magnitude (i.e., distance) of these vectors for separating the data points in 2D space 
and computing the experimental variogram. Actually, we computed the so-called 
omnidirectional variogram. However, we may assume that there is a specific direction in 
the geographical space (e.g., in the East-West direction) along which the data shows 
stronger correlation than in the others. Directional variograms are in use to explore and 
determine the direction along which the data show stronger (or weaker) spatial continuity 
(or correlation). When computing a directional variogram not only the magnitude of the 
separation vectors but also their direction is used for creating data pairs for variogram 
computation. That makes it possible to yield an experimental variogram, which shows 
the spatial variability of the phenomenon in a specific direction (e.g., in the North-South 
direction). In theory, we can select any direction in 2D space and thus a directional 
variogram can be computed in any direction. Therefore, we can create a map, which 
represents the value of directional variograms computed in each direction of 2D space. 
This map is known in geostatistics as variogram surface or variogram map. Using the 
function “variogram”, we shall compute some directional variograms for the cadmium 
data contained in the Meuse data set and then create the variogram surface: 
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v.cd <- variogram(log(cadmium)~1, meuse, alpha=c(0,45,90,135)) # Compute some 
directional variograms 
plot(v.cd, main="Directional variograms (Cd)") 

 
Figure 168. Directional variograms computed for the cadmium concentration in various 

directions (i.e., N-S, NE-WS, W-E, and NW-SE). 

 
Figure 169. Variogram surface (or variogram map) of cadmium concentration. 

v.cd.vs <- variogram(log(cadmium)~1, meuse, width=300, cutoff=1500, map=TRUE) 
# Create the variogram surface 
plot(v.cd.vs, main="Variogram surface (Cd)") 
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By the parameter “alpha” we can specify the directions in which the directional 
variogram should be computed. The parameter “alpha” can take positive degrees in 
clockwise, where 0 is the direction in North-South (N-S) and 90 is the direction in West-
East (W-E). In Figure 8, we computed directional variograms in N-S (alpha=0), NE-WS 
(alpha=45), W-E (alpha=90), and NW-SE (alpha=135). We can see that the computed 
directional variograms shows a more erratic structure because a fewer number of data 
pairs fall in a specific direction than in the omnidirectional case (when the direction does 
not really matter). It may make a bit difficult to fit a variogram model. We can observe 
that the strongest spatial correlation (or continuity) between the cadmium data is in the 
NE-SW direction (alpha=45) with a range value of about 2000 m, which is also supported 
by the computed variogram surface (Figure 168 and 169). Besides, it is also apparent that 
in the NW-SE direction, which is perpendicular to the NE-SW direction, the spatial 
correlation is the weakest between the cadmium data with a range value of about 750 m 
(Figure 168 and 169). The direction of the strongest and the weakest spatial correlation 
are known as major and minor range, respectively. 

It is not an easy task to fit a proper and permissible variogram model to the directional 
variograms. Furthermore, we should assume that the directional variograms form a so-
called geometric anisotropy, which briefly means that the sill of the directional 
variograms is constant and only the range of the directional variograms change so that 
they follow an ellipse’s perimeter on the variogram surface, and the major range is in the 
major axis and the minor range is in the minor axis of the ellipse. The function 
“fit.variogram” can fit a variogram model to directional variograms with geometric 
anisotropy: 

vgm.cd <- fit.variogram(v.cd, vgm(psill=1.5, model="Sph", range=2000, nugget=0
.5, anis=c(45,0.375))) # Fit an anisotropic variorgam model 
vgm.cd # Show the fitted anisotropic variogram model 

##   model     psill   range ang1 anis1 
## 1   Nug 0.5755737    0.00    0 1.000 
## 2   Sph 1.3225778 2399.09   45 0.375 

plot(v.cd, vgm.cd) 

In this case, not just the well-known parameters (i.e., partial sill, range, and nugget) but 
the parameters of the anisotropy (i.e., “anis=c(45, 0.375)”) had to be given in the function 
“vgm”. Note that the first value is the angle of the major range in degree (i.e., 45 because 
we observed that the major range is in the NE-SW direction (see Figure 168 and 169)) 
and the second value is the minor to major range ratio (i.e., 750/2000=0.375). We can see 
that the fitted anisotropic variogram model fairly fits to the directional variograms (Figure 
170). 
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Figure 170. Directional variograms computed for the cadmium concentration (blue circles) and 

the fitted theoretical variogram model (solid blue line). 

5 Kriging 
In general, kriging, named by Georges Matheron after Danie Krige (due to his pioneering 
work in the field of geostatistics), is a linear spatial prediction (or spatial estimation) 
technique that uses the variogram (or the covariance) to account for the spatial structure 
of the phenomenon under study and minimizes the prediction-error variance determined 
by the geometry of the data points. Kriging is a family of generalized least-squares 
regression algorithms. Thus, all kriging algorithms are but variants of the basic linear 
regression estimator Z*(u) defined as (Goovaerts, 1997): 

 
𝑍∗(𝐮) − 𝑚(𝐮) = 𝜆 (𝐮) ∗ [𝑍(𝐮 ) − 𝑚(𝐮 )]

(𝐮)

 (6) 

where n(u) is the number of the observations, λα(u) is the weight assigned to z(uα) 
interpreted as a realization of the random variable Z(uα), m(u) and m(uα) are the expected 
values of the random variables Z(u) and Z(uα), respectively (Goovaerts, 1997). All 
kriging types share the same objective, which is minimizing the estimation variance (also 

known as prediction-error variance or kriging variance) 𝜎 (𝐮): 
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 𝜎 (𝐮) = Var[𝑍∗(𝐮) − 𝑍(𝐮)] (7) 

under the following constraint: 

 E[𝑍∗(𝐮) − 𝑍(𝐮)] = 0 (8) 

That is why we commonly say that kriging is the “best linear unbiased predictor or 
estimator” (BLUP or BLUE) (Webster and Oliver, 2007): 

- Best because the kriging variance is minimized, 
- Linear as it is a linear regression estimator, 
- Unbiased because the constraint above (Eq. 8) ensure that the estimate is not 

biased in theory. 

There are various types of kriging, which mainly depend on the model adopted for the 
random function (Goovaerts, 1997), just to name a few: 

- Simple kriging where we consider the mean is known and constant over the study 
area, 

- Ordinary kriging where we do not know the mean of the spatial phenomenon 
over the area under study, 

- Regression kriging (also known as universal kriging or kriging with external 
drift) where we consider the local mean varies over the area of interest, which 
can be modelled and removed by using spatially exhaustive environmental 
covariates. 

In this section, we shall take a closer look at two kriging algorithms, namely ordinary 
kriging and regression kriging, and how they can be used for spatial prediction on the 
example of the Meuse data set. 

5.1 Ordinary kriging 
Probably the most frequently and widely used geostatistical estimation algorithm is 
ordinary kriging, which is based on the assumption that we do not know the mean of the 
spatial phenomenon over the area under study (Webster and Oliver, 2007). However, it 
allows us to account for local variation of the mean by limiting the domain of stationarity 
of the mean to the local neighborhood centered on the location of the point being 
estimated (Goovaerts, 1997). The estimator is the linear combination of the random 
variables plus the constant local mean that is 

 
𝑍∗(𝐮) = 𝜆 (𝐮) ∗ 𝑍(𝐮 )

(𝐮)

+ 1− 𝜆 (𝐮)

(𝐮)

∗ 𝑚(𝐮) (9) 



        

129 
 

where Z*(u) is the prediction for the random variable at location u, λα(u) are the kriging 
weights at location u, Z(uα) are the random variables at the data points, n(u) is the number 
of data points, and m(u) is the unknown local mean. The latter is filtered from the 
estimator above by forcing the kriging weights to sum to 1 and thus the ordinary kriging 
estimator is a linear combination only of the random variables: 

 
𝑍∗ (𝐮) = 𝜆 (𝐮) ∗ 𝑍(𝐮 )

(𝐮)

 (10) 

with 

 
𝜆

(𝐮)

= 1 (11) 

where 𝜆  are the ordinary kriging weights, which are determined to minimize the 
prediction error variance: 

 
𝜎 (𝐮) = 𝜆 𝛾(𝐮 , 𝐮)

(𝐮)

+ 𝜓(𝐮) (12) 

where 𝜎 (𝐮) is the prediction error variance of ordinary kriging (or simply the ordinary 
kriging variance), γ(uα,u) are the semivariances between the data points uα and the 
location u, and ψ(u) is the Lagrange multiplier. We should note that ordinary kriging is 
an exact interpolator in the sense that if a prediction location happens to be one of the 
data points, then the ordinary kriging prediction is equal to the data point value and its 
ordinary kriging variance is zero. 

In the rest of this subsection, we shall use ordinary kriging for predicting the spatial 
distribution (or spatial variability) of the zinc data contained in the Meuse data set. 
Ordinary kriging prediction will be performed on the Meuse raster stack loaded and 
preprocessed in Section 3. First, we take a look at those locations at which ordinary 
kriging will be performed (Figure 171): 

plot(as(meuse.grid, "SpatialPointsDataFrame")) # Plot grid points at which ord
inary kriging will be performed 
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Figure 171. Locations over the study area (signed by “+”) at which ordinary kriging prediction 

will be performed. 

There are a bit more than 3,000 locations at which we would like to predict the value of 
zinc concentration by using ordinary kriging (Figure 171). This means that we have to 
solve the equations above that many times. Fortunately, the function “krige” of the R 
package “gstat” can automatically do it without any trouble. In the course of ordinary 
kriging, we shall use (i) the “SpatialPointsDataFrame” object of the Meuse data set 
(“meuse”) in which zinc observations and their coordinates are stored, (ii) the theoretical 
variogram model fitted to the experimental variogram of the log-transformed zinc data 
(“vgm.zn”), and (iii) the SpatialPixelsDataFrame object of the Meuse raster stack 
(“meuse.grid”) as input grid defining those locations at which spatial prediction for zinc 
concentration are required: 

zinc.ok <- krige(log(zinc)~1, meuse, meuse.grid, vgm.zn, debug.level=-1) # Ord
inary kriging of the log-transformed zinc data 

## [using ordinary kriging] 
## 100% done 

Note that the formula “log(zinc)~1” defines that the variable of interest is the log-
transformed zinc. Furthermore, we set the parameter “debug.level” to “-1” in order to get 
a progress bar about the execution of ordinary kriging. After ordinary kriging has been 
executed, we take a quick look at the results by using the basic functions “str” and 
“summary”: 
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str(zinc.ok) # Take a look at the structure of the results 

## Formal class 'SpatialPixelsDataFrame' [package "sp"] with 7 slots 
##   ..@ data       :'data.frame':  3103 obs. of  2 variables: 
##   .. ..$ var1.pred: num [1:3103] 6.5 6.62 6.51 6.39 6.76 ... 
##   .. ..$ var1.var : num [1:3103] 0.32 0.252 0.273 0.296 0.178 ... 
##   ..@ coords.nrs : int [1:2] 1 2 
##   ..@ grid       :Formal class 'GridTopology' [package "sp"] with 3 slots 
##   .. .. ..@ cellcentre.offset: Named num [1:2] 178460 329620 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   .. .. ..@ cellsize         : Named num [1:2] 40 40 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   .. .. ..@ cells.dim        : Named int [1:2] 78 104 
##   .. .. .. ..- attr(*, "names")= chr [1:2] "x" "y" 
##   ..@ grid.index : int [1:3103] 69 146 147 148 223 224 225 226 300 301 ... 
##   ..@ coords     : num [1:3103, 1:2] 181180 181140 181180 181220 181100 ... 
##   .. ..- attr(*, "dimnames")=List of 2 
##   .. .. ..$ : chr [1:3103] "1" "2" "3" "4" ... 
##   .. .. ..$ : chr [1:2] "x" "y" 
##   ..@ bbox       : num [1:2, 1:2] 178440 329600 181560 333760 
##   .. ..- attr(*, "dimnames")=List of 2 
##   .. .. ..$ : chr [1:2] "x" "y" 
##   .. .. ..$ : chr [1:2] "min" "max" 
##   ..@ proj4string:Formal class 'CRS' [package "sp"] with 1 slot 
##   .. .. ..@ projargs: chr NA 

summary(zinc.ok) # Summary of the results 

## Object of class SpatialPixelsDataFrame 
## Coordinates: 
##      min    max 
## x 178440 181560 
## y 329600 333760 
## Is projected: NA  
## proj4string : [NA] 
## Number of points: 3103 
## Grid attributes: 
##   cellcentre.offset cellsize cells.dim 
## x            178460       40        78 
## y            329620       40       104 
## Data attributes: 
##    var1.pred        var1.var       
##  Min.   :4.777   Min.   :0.08549   
##  1st Qu.:5.238   1st Qu.:0.13728   
##  Median :5.573   Median :0.16218   
##  Mean   :5.707   Mean   :0.18533   
##  3rd Qu.:6.172   3rd Qu.:0.21161   
##  Max.   :7.440   Max.   :0.50028 

We can see that the object (“zinc.ok”), which contains all the results of ordinary kriging, 
has the same class as the Meuse raster stack (i.e., “SpatialPixelsDataFrame”). In addition, 
their grid definitions are the same too. In the summary, we can see that the object 
“zinc.ok” contains two attributes, namely “var1.pred” and “var1.var”, which refer to the 
ordinary kriging prediction (i.e., ZOK*) and the ordinary kriging prediction error variance 

(i.e., 𝜎 (𝐮)), respectively. We should note that ordinary kriging has been performed on 
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the log-transformed zinc data and therefore there is a need to transform the ordinary 
kriging predictions back to the original, lognormal scale in order to obtain understandable 
results on the spatial distribution of zinc concentration. For this purpose, we can use the 
following equation: 

 
𝑦(𝐮) = exp 𝑧 (𝐮) +

𝜎 (𝐮)

2
 (13) 

where y(u) is the back-transformed zinc value at location u, zOK(u) and 𝜎 (𝐮) are the 
ordinary kriging prediction and the associated ordinary kriging variance at location u, 
respectively, and exp(.) is for exponentiation. Now, transform the zinc predictions back 
to the original scale in R environment and then plot the resulting maps: 

zinc.ok$zinc.backtr <- exp(zinc.ok$var1.pred + (zinc.ok$var1.var)/2) # Transfo
rm the results back to the original, lognormal scale 
 
summary(zinc.ok) # Summary of the results 

## Object of class SpatialPixelsDataFrame 
## Coordinates: 
##      min    max 
## x 178440 181560 
## y 329600 333760 
## Is projected: NA  
## proj4string : [NA] 
## Number of points: 3103 
## Grid attributes: 
##   cellcentre.offset cellsize cells.dim 
## x            178460       40        78 
## y            329620       40       104 
## Data attributes: 
##    var1.pred        var1.var        zinc.backtr     
##  Min.   :4.777   Min.   :0.08549   Min.   : 126.3   
##  1st Qu.:5.238   1st Qu.:0.13728   1st Qu.: 205.2   
##  Median :5.573   Median :0.16218   Median : 285.5   
##  Mean   :5.707   Mean   :0.18533   Mean   : 396.2   
##  3rd Qu.:6.172   3rd Qu.:0.21161   3rd Qu.: 536.1   
##  Max.   :7.440   Max.   :0.50028   Max.   :1832.2 

plot04 <- spplot(zinc.ok["var1.pred"], main="log(zinc) prediction") # Map of l
og-transformed zinc prediction 
plot05 <- spplot(zinc.ok["var1.var"], main="log(zinc) error variance") # Map o
f prediction error variance 
plot06 <- spplot(zinc.ok["zinc.backtr"], main="Zinc prediction [ppm]") # Map o
f Zinc prediction at the original, lognormal scale 
 
print(plot04, split=c(1,1,3,1), more=TRUE) 
print(plot05, split=c(2,1,3,1), more=TRUE) 
print(plot06, split=c(3,1,3,1), more=FALSE) # Plot the maps next to each other 
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Figure 172. Results of ordinary kriging: spatial prediction at the log-transformed scale (left 

map), prediction error variance of ordinary kriging (middle map), and spatial prediction at the 
original, quasi lognormal scale (right map). 

In Figure 172, we can see that the third map shows the spatial distribution of zinc 
concentration in the soil for the area under study. Note that it is easy to identify the 
location of the zinc data points in the map of kriging variance (Figure 172, middle map) 
as the lower the kriging variance, the closer the prediction location to a data point. 

5.2 Regression kriging 
Over the past two decades, regression kriging has received increasing attention as it can 
handle systematic change in the mean of the observations (i.e., trend or drift), which 
refutes even the weakest type of stationarity (i.e., intrinsic hypothesis) (see Section 1.3. 
and 4.2.), furthermore, it can also take spatially exhaustive environmental covariates into 
account in the course of spatial modelling, which frequently improve spatial prediction 
accuracy (Hengl et al., 2004, 2007). According to its definition, regression kriging 
combines the regression of the variable of interest on spatially exhaustive secondary 
information with simple kriging of the regression residuals to estimate the value of the 
variable of interest at an unvisited location. In the light of the definition above, the 
regression kriging can be written as follows, using the basic linear regression estimator 
(Eq. 6): 

 
𝑍∗ (𝐮) − 𝑚∗ (𝐮) = 𝜆 (𝐮) ∗ [𝑍(𝐮 ) − 𝑚∗ (𝐮 )]

(𝐮)

 (14) 

where 𝜆 (𝐮) is the simple kriging weight, n(u) is the number of observations, and 
𝑚∗ (𝐮) and 𝑚∗ (𝐮 ) are the expected values of the random variables Z(u) and Z(uα), 
respectively. By rearranging the equation above and then decomposing 𝑚∗ (𝐮) and 
𝑚∗ (𝐮 ), we get the following equation: 
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𝑍∗ (𝐮) = 𝛽 ∗ 𝑞 (𝐮) + 𝜆 (𝐮) ∗ 𝑍(𝐮 ) − 𝛽 ∗ 𝑞 (𝐮 )

(𝐮)

 (15) 

where 𝛽  is the regression coefficient assigned to the kth environmental covariate, 𝑝 is 
the number of environmental covariates involved into regression kriging, 𝑞 (𝐮) and 
𝑞 (𝐮 ) are the values of the kth environmental covariate at locations 𝐮 and 𝐮 , 
respectively. If there are no environmental covariates (i.e., 𝑘 = 0), then 𝑞 (𝐮) ≡ 1. We 
should note that the first term on the right-hand side of Eq. 15 is the (multiple) linear 
regression estimator, whereas the second term on the right hand side is the simple kriging 
estimator that uses the estimated values of the linear regression at the observation 
locations as expected values. Using matrix notation, the regression kriging estimator (Eq. 
15) can be written as: 

 𝑍∗ (𝐮) = 𝐪 (𝐮) ∗ 𝛃 + 𝛌 (𝐳 − 𝐐 ∗ 𝛃 ) (16) 

where 𝐪(𝐮) is the vector of environmental covariates at location u, 𝛃  is the vector of 

regression coefficients, 𝛌  is the vector of the simple kriging weights, 𝐳 is the vector of 
the observations, 𝐐 is the (𝑛 × 𝑝 + 1) matrix of the secondary information at the 
observation locations (also known as design matrix), and T (in the superscript) stands for 
transpose. As in the case of ordinary kriging (Section 5.1.), our objective is to minimize 
the prediction error variance of regression kriging as well: 

 𝜎 (𝐮) = 𝐶(0) − 𝐜 ∙ 𝛌 (𝐮) + [𝐪(𝐮) − 𝐐 ∙ 𝛌 (𝐮)]

∙ 𝐐 ∙ 𝐂 ∙ 𝐐 ∙ [𝐪(𝐮) − 𝐐 ∙ 𝛌 (𝐮)] 
(17) 

where 𝐶(0) is the a priori variance of the residuals, 𝐜 is the vector of covariances between 
the locations 𝐮 and 𝐮 , and 𝐂  is the (𝑛 × 𝑛) covariance matrix of the residuals. 

In the rest of this subsection, we shall use regression kriging for predicting the spatial 
distribution (or spatial variability) of the zinc data contained in the Meuse data set at 
locations presented in Figure 11. As it has been already mentioned (see Section 3), the 
process governing heavy metal distribution seems that polluted sediment is carried by the 
river, and mostly deposited close to the riverbank, and areas with low elevation. Thus, 
we shall use the distance to the river as spatially exhaustive environmental covariate 
(Figure 173), which has been normalized to [0,1] over the area under study. 

spplot(meuse.grid["dist"], main="Distance to the River Meuse", sub="normalized 
to [0,1]") # Plot the distance to the River Meuse 
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Figure 173. Distance to the River Meuse used as environmental covariate in regression kriging. 
Annotation: Distance values have been normalized to [0,1]. 

In regression kriging, the first step is to fit a linear regression model between the log-
transformed zinc values and the distances to the river that are also stored in the 
“SpatialPointsDataFrame” object of the Meuse data set (“meuse”). This can readily be 
done by using the basic function “lm”: 

mlr.zn <- lm(log(zinc)~dist, meuse) # Fit a linear regression model 
summary(mlr.zn) # Give a summary of the fitted regression model 

##  
## Call: 
## lm(formula = log(zinc) ~ dist, data = meuse) 
##  
## Residuals: 
##      Min       1Q   Median       3Q      Max  
## -1.12573 -0.36442 -0.00161  0.31932  1.67774  
##  
## Coefficients: 
##             Estimate Std. Error t value Pr(>|t|)     
## (Intercept)  6.53380    0.06172  105.87   <2e-16 *** 
## dist        -2.69991    0.19874  -13.59   <2e-16 *** 
## --- 
## Signif. codes:  0 '***' 0.001 '**' 0.01 '*' 0.05 '.' 0.1 ' ' 1 
##  
## Residual standard error: 0.4876 on 153 degrees of freedom 
## Multiple R-squared:  0.5468, Adjusted R-squared:  0.5438  
## F-statistic: 184.6 on 1 and 153 DF,  p-value: < 2.2e-16 
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The summary of the fitted linear regression model gives a quite detailed overview on the 
model statistics, for example, the fitted regression coefficients, including the intercept 
and the coefficient fitted to the distance to river, the computed R-square values, and some 
statistics associated with regression analysis (e.g., F-statistic, degrees of freedom, and 
observed p-value). In regression kriging, we shall interpret the computed R-square value 
as the proportion of variance that is explained by the fitted regression model. In our case 
the R-square is about 0.55, which means that the fitted model explains more than 50% of 
the total variation of zin concentration over the area under study. The next step is to 
compute the experimental variogram of the regression residuals over the study area: 

v.res <- variogram(log(zinc)~dist, meuse) # Compute the experimental variogram 
of the regression residuals 
plot(v.res, main="Variogram of the regression residuals") # Plot the experimen
tal variogram 

 
Figure 174. Experimental variogram computed for the regression residuals. 

Comparing the experimental variogram of the regression residuals (Figure 174) with the 
experimental variogram of the log-transformed zinc data (Figure 163), we see that their 
shapes and ranges are quite similar. However, the sill of the regression residuals is about 
50% lower than that of the log-transformed zinc variogram. This can be attributed to the 
fact that the fitted regression model explains about 50% of the total variation of the log-
transformed zinc data and therefore the residuals represent the remaining 50% of the total 
variation, which is equal to the sill in this case. We shall fit a permissible analytical 
variogram model to the experimental variogram computed for the regression residuals 
(Figure 174): 
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vgm.res <- fit.variogram(v.res, vgm(psill=0.26, model="Sph", range=1000, nugge
t=0.1)) # Fit a theoretical model to the experimental variogram 
vgm.res # Show the fitted theoretical model 

##   model      psill    range 
## 1   Nug 0.07642494   0.0000 
## 2   Sph 0.20529396 728.6942 

plot(v.res, vgm.res, main="Experimental variogram and the fitted model") # Plo
t the fitted model and the experimental variogram 

 
Figure 175. Experimental variogram computed for the regression residuals (blue 

circles) and the fitted theoretical variogram model (solid blue line). 

In model fitting, we used the values determined in the interpretation of the experimental 
variogram of log-transformed zinc data (see Section 4.2.) as initial values for range and 
nugget. The partial sill was set to 0.26 that is about 50% of the variance of the log-
transformed zinc data minus the nugget variance (i.e., 0.1). Figure 175 shows both the 
fitted and the experimental variograms, and we can confirm that the model fits quite well. 

In the course of regression kriging, we shall use the function “krige” of the R package 
“gstat” with the inputs as follows: (i) the “SpatialPointsDataFrame” object of the Meuse 
data set (“meuse”) in which zinc observations and their coordinates are stored, (ii) the 
theoretical variogram model fitted to the experimental variogram of the regression 
residuals (“vgm.res”), and (iii) the SpatialPixelsDataFrame object of the Meuse raster 
stack (“meuse.grid”), which contains the distance to the river used as spatially exhaustive 
environmental covariate: 

zinc.rk <- krige(log(zinc)~dist, meuse, meuse.grid, vgm.res, debug.level=-1) # 
Regression kriging of the log-transformed zinc data 

## [using universal kriging] 
## 100% done 
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zinc.rk$zinc.backtr <- exp(zinc.rk$var1.pred + (zinc.rk$var1.var)/2) # Transfo
rm the results back to the original, lognormal scale 
 
summary(zinc.rk) # Summary of the results 

## Object of class SpatialPixelsDataFrame 
## Coordinates: 
##      min    max 
## x 178440 181560 
## y 329600 333760 
## Is projected: NA  
## proj4string : [NA] 
## Number of points: 3103 
## Grid attributes: 
##   cellcentre.offset cellsize cells.dim 
## x            178460       40        78 
## y            329620       40       104 
## Data attributes: 
##    var1.pred        var1.var       zinc.backtr      
##  Min.   :4.067   Min.   :0.1034   Min.   :  65.81   
##  1st Qu.:5.195   1st Qu.:0.1270   1st Qu.: 193.82   
##  Median :5.598   Median :0.1379   Median : 288.78   
##  Mean   :5.688   Mean   :0.1488   Mean   : 390.66   
##  3rd Qu.:6.196   3rd Qu.:0.1606   3rd Qu.: 528.91   
##  Max.   :7.334   Max.   :0.2825   Max.   :1635.54 

plot07 <- spplot(zinc.rk["var1.pred"], main="log(zinc) prediction") # Map of l
og-transformed zinc prediction 
plot08 <- spplot(zinc.rk["var1.var"], main="log(zinc) error variance") # Map o
f prediction error variance 
plot09 <- spplot(zinc.rk["zinc.backtr"], main="Zinc prediction [ppm]") # Map o
f Zinc prediction at the original, lognormal scale 
 
print(plot07, split=c(1,1,3,1), more=TRUE) 
print(plot08, split=c(2,1,3,1), more=TRUE) 
print(plot09, split=c(3,1,3,1), more=FALSE) # Plot the maps next to each other 

 
Figure 176. Results of regression kriging: spatial prediction at the log-transformed scale (left 
map), prediction error variance of regression kriging (middle map), and spatial prediction at 

the original, quasi lognormal scale (right map). 
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We should note that regression kriging has been also performed on the log-transformed 
zinc data and therefore there was a need to transform the regression kriging predictions 
back to the original, lognormal scale in order to obtain understandable results on the 
spatial distribution of zinc concentration. For this purpose, we used Eq. 13 again. In 
Figure 176, we can see that the third map shows the spatial distribution of zinc 
concentration predicted by regression kriging. Comparing it with the map predicted by 
ordinary kriging (Figure 172, right map), we can see that the two maps are different in 
details, e.g., regression kriging give a more detailed picture about the spatial distribution 
of zinc concentration close to the river, especially in the southwestern part of the study 
area, thanks to distance to river used as environmental covariate in the course of spatial 
modelling. 

5.3 Cross-validation 
In practice, a common requirement is to provide some quantitative information about the 
goodness of a spatial prediction. To satisfy such a demand on the quality of the spatial 
prediction, we frequently use cross-validation. In the case of k-fold cross-validation, the 
data points are randomly divided into k equally sized subsets. One of these subsets is 
retained for validating the spatial predictions, which are given by using the k–1 remaining 
subsets. This step is repeated until each of the k subsets become a validation set exactly 
once. As a results, we get a predicted and observed value for each data point, which can 
be used for computing certain error measures (see later). We should note that a special 
case of k-fold cross-validation is leave-one-out cross-validation where only one data 
point is temporally removed and the n–1 data points are used for giving a prediction at 
the temporally removed data point. 

K-fold cross-validation can be readily done by using the function “krige.cv” of the R 
package “gstat”. We shall use it for providing some quantitative information about the 
accuracy of the spatial predictions given by ordinary kriging and regression kriging. The 
function “krige.cv” can be similarly parametrized as the function “krige”. The only 
difference is that we have to leave the “meuse.grid” out: 

zinc.ok.10.fold <- krige.cv(log(zinc)~1, meuse, vgm.zn, nfold=10) # 10-fold cr
oss-validation for ordinary kriging 
zinc.rk.10.fold <- krige.cv(log(zinc)~dist, meuse, vgm.res, nfold=10) # 10-fol
d cross-validation for regression kriging 
 

summary(zinc.ok.10.fold) 

## Object of class SpatialPointsDataFrame 
## Coordinates: 
##      min    max 
## x 178605 181390 
## y 329714 333611 
## Is projected: NA  
## proj4string : [NA] 
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## Number of points: 155 
## Data attributes: 
##    var1.pred        var1.var         observed        residual          
##  Min.   :4.867   Min.   :0.1191   Min.   :4.727   Min.   :-0.9457349   
##  1st Qu.:5.395   1st Qu.:0.1632   1st Qu.:5.288   1st Qu.:-0.2097640   
##  Median :5.868   Median :0.1856   Median :5.787   Median :-0.0072369   
##  Mean   :5.886   Mean   :0.1955   Mean   :5.886   Mean   :-0.0000203   
##  3rd Qu.:6.317   3rd Qu.:0.2113   3rd Qu.:6.514   3rd Qu.: 0.2002833   
##  Max.   :7.245   Max.   :0.6296   Max.   :7.517   Max.   : 1.4543276   
##      zscore               fold        
##  Min.   :-2.183050   Min.   : 1.000   
##  1st Qu.:-0.496718   1st Qu.: 3.000   
##  Median :-0.018426   Median : 6.000   
##  Mean   : 0.003161   Mean   : 5.748   
##  3rd Qu.: 0.455539   3rd Qu.: 8.000   
##  Max.   : 2.967274   Max.   :10.000 

summary(zinc.rk.10.fold) 

## Object of class SpatialPointsDataFrame 
## Coordinates: 
##      min    max 
## x 178605 181390 
## y 329714 333611 
## Is projected: NA  
## proj4string : [NA] 
## Number of points: 155 
## Data attributes: 
##    var1.pred        var1.var         observed        residual         
##  Min.   :4.378   Min.   :0.1164   Min.   :4.727   Min.   :-0.992358   
##  1st Qu.:5.359   1st Qu.:0.1362   1st Qu.:5.288   1st Qu.:-0.199612   
##  Median :5.874   Median :0.1450   Median :5.787   Median : 0.020646   
##  Mean   :5.879   Mean   :0.1509   Mean   :5.886   Mean   : 0.006822   
##  3rd Qu.:6.374   3rd Qu.:0.1574   3rd Qu.:6.514   3rd Qu.: 0.186238   
##  Max.   :7.131   Max.   :0.2779   Max.   :7.517   Max.   : 1.540793   
##      zscore              fold        
##  Min.   :-2.50697   Min.   : 1.000   
##  1st Qu.:-0.52582   1st Qu.: 3.000   
##  Median : 0.05114   Median : 5.000   
##  Mean   : 0.01260   Mean   : 5.535   
##  3rd Qu.: 0.49203   3rd Qu.: 8.000   
##  Max.   : 3.99332   Max.   :10.000 

The formula “log(zinc)~1” defines that the variable of interest is the log-transformed 
zinc. The resulting objects are of class “SpatialPointsDataFrame” and contain a number 
of attributes, for example: 

- var1.pred: predicted values computed in cross-validation, 
- var1.var: prediction error variance computed in cross-validation, 
- observed: observed values of the variable of interest, and 
- residual: the difference between the predicted and the observed values (i.e., 

var1.pred” minus “observed”); also known as error. 
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Note that cross-validation was carried out at the transformed, normal scale and therefore 
we have to transform the results back to the original, lognormal scale in order to obtain 
understandable results on cross-validation. This can be readily done by using Eq. 13 
again: 

zinc.ok.10.fold$zinc.backtr <- exp(zinc.ok.10.fold$var1.pred + (zinc.ok.10.fol
d$var1.var)/2) # Transform the ordinary kriging predictions back to the origia
nl, lognormal scale 
zinc.rk.10.fold$zinc.backtr <- exp(zinc.rk.10.fold$var1.pred + (zinc.rk.10.fol
d$var1.var)/2) # Transform the regression kriging predictions back to the orig
ianl, lognormal scale 

The most commonly used error measures, which are computed based on the results of 
cross-validation, are the mean error (ME), which is also known as bias, and the root mean 
square error (RMSE), which is also known as the spread of the error distribution. They 
can be computed by the following equations: 

 
𝑀𝐸 =

1

𝑛
[𝑧 (𝐮 ) − 𝑧 (𝐮 )] (18) 

and 

 

𝑅𝑀𝑆𝐸 =
1

𝑛
[𝑧 (𝐮 ) − 𝑧 (𝐮 )]  (19) 

where n is the number of data points, zpred(ui) and zobs(ui) are the predicted and observed 
value for the variable of interest at data point ui, respectively. An important aim of every 
spatial prediction procedure is to provide spatial prediction without bias (i.e., value of 
ME close to zero) and with RMSE as low as possible. The errors and the error measures 
introduced above can be easily computed: 

error.ok <- zinc.ok.10.fold$zinc.backtr - meuse$zinc # Compute the errors for 
ordinary kriging predictions 
error.rk <- zinc.rk.10.fold$zinc.backtr - meuse$zinc # Compute the errors for 
regression kriging predictions 
 

mean(error.ok) # Compute the mean error for ordinary kriging 

## [1] -8.207483 

sqrt(mean(error.ok^2)) # Compute the root mean square error for ordinary krigi
ng 

## [1] 235.6821 
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mean(error.rk) # Compute the mean error for regression kriging 

## [1] -7.360334 

sqrt(mean(error.rk^2)) # Compute the root mean square error for regression kri
ging 

## [1] 205.4015 

According to the values of ME, both kriging techniques slightly underestimated the zinc 
concentration on average. However, based on the values of RMSE we can say that spatial 
prediction of regression kriging is more accurate than that of ordinary kriging as RMSE 
computed for regression kriging is the lowest. This means that regression kriging 
outperformed ordinary kriging. It is also a good practice to present the histogram of the 
errors (Figure 177) and a scatterplot (Figure 178), which shows the predicted and 
observed values: 

par(mfrow=c(1,2)) 
hist(error.ok, xlab="Error", main="Histogram of the errors", sub="ordinary kri
ging", col="lightblue") # Histogram for ordinary kriging 
hist(error.rk, xlab="Error", main="Histogram of the errors", sub="regression k
riging", col="lightblue") # Histogram for regression kriging 

 
Figure 177. Histogram of the errors computed for ordinary kriging (left graph) and for 

regression kriging (right graph). 

par(mfrow=c(1,2)) 
plot(zinc.ok.10.fold$zinc.backtr, meuse$zinc, xlab="Predicted values", ylab="O
served values", main="Predicted vs. observed values", sub="ordinary kriging") 
# Scatterplot for ordinary kriging predictions 
abline(0,1,col="red") # Add the 1:1 line (i.e., y=x) to the scatterplot 
plot(zinc.rk.10.fold$zinc.backtr, meuse$zinc, xlab="Predicted values", ylab="O
served values", main="Predicted vs. observed values", sub="regression kriging"
) # Scatterplot for regression kriging predictions 
abline(0,1,col="red") # Add the 1:1 line (i.e., y=x) to the scatterplot 
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Figure 178. Scatterplot of the observed and predicted values for ordinary kriging (left graph) 

and for regression kriging (right graph). 

Although there are few extreme negative values on both histograms, Figure 177 shows 
that the distribution of the errors is fairly symmetric around zero, which means that there 
is no systematic over- or underestimation of the true values, therefore we can say that the 
spatial prediction of zinc concentration is fairly unbiased. Note that RMSE is a measure 
of the spread of the error distribution (i.e., histogram) as it has been already defined 
above. Figure 178 visualizes the relationship between the predicted and observed values. 
We frequently add the 1:1 line (i.e., y=x) to the scatterplot. The closer the points to the 
1:1 line, the more accurate the prediction. 

6 Exporting results from R environment 

Once we have had spatial prediction by kriging and the results of cross-validation have 
already confirmed that spatial prediction is acceptably accurate for the problem in hand, 
then we frequently want to export the resulting spatial prediction to GIS files, which 
allow us to import and use the results in advanced GIS software. We shall use the R 
package “raster” to export the results of geostatistical modelling. 

First, we have to create objects of class “RasterLayer” based on the objects of class 
“SpatialPixelsDataframe” (i.e., “zinc.ok” and “zinc.rk”), which can be easily done by the 
function “raster” of the R package “raster”: 
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zinc.ok.pred <- raster(zinc.ok["zinc.backtr"]) # Rasterize the back-transforme
d ordinary kriging prediction 
zinc.ok.var <- raster(zinc.ok["var1.var"]) # Rasterize the prediction error va
riance of ordinary kriging 
zinc.rk.pred <- raster(zinc.rk["zinc.backtr"]) # Rasterize the back-transforme
d regression kriging prediction 
zinc.rk.var <- raster(zinc.rk["var1.var"]) # Rasterize the prediction error va
riance of regression kriging 
 
par(mfrow=c(2,2)) 
plot(zinc.ok.pred, main="Ordinary kriging prediction") 
plot(zinc.rk.pred, main="Regression kriging prediction") 
plot(zinc.ok.var, main="Ordinary kriging variance") 
plot(zinc.rk.var, main="Regression kriging variance") # 2X2 matrix of maps 

 
Figure 179. Results of regression kriging and ordinary kriging: maps of prediction error 

variance (last row) and maps of kriging predictions (first row). 

Note that any attributes can be converted to an object of class “RasterLayer” by giving 
the name of the attribute in square brackets (e.g., [“zinc.backtr”] or [“var1.var”]). Now, 
all the important results are objects of class “RasterLayer”, and we can also present them 
graphically as we can see in Figure 179. In the next step, we shall use the function 
“writeRaster” of the package “raster” to export the results into GeoTIFF files, which type 
of file formats is frequently used in GIS: 



        

145 
 

writeRaster(zinc.ok.pred, filename="zinc_pred_OK.tif", format="GTiff", overwri
te=TRUE) # Export ordinary kriging prediction as GeoTIFF file 

writeRaster(zinc.ok.var, filename="zinc_var_OK.tif", format="GTiff", overwrite
=TRUE) # Export ordinary kriging variance as GeoTIFF file 

writeRaster(zinc.rk.pred, filename="zinc_pred_RK.tif", format="GTiff", overwri
te=TRUE) # Export regression kriging prediction as GeoTIFF file 

writeRaster(zinc.rk.var, filename="zinc_var_RK.tif", format="GTiff", overwrite
=TRUE) # Export regression kriging variance as GeoTIFF file 

We should note that the function used above supports exporting not just GeoTIFF files 
but also a number of GIS file formats, which are specific for certain GIS software, such 
as ESRI, SAGA GIS, IDRISI, ENVI or Erdas Imagine. Note that in the parameter 
“filename” you can specify not just the name of the output file with the extension but also 
an already existing path, where you want to export the output file. This can be simply 
done by typing, for example, “C:/MyFirst_kriging_exercise/zinc_pred.tif”. We should 
note that the full path has to be separated by slash (i.e., “/”) and not by backslash (i.e., 
“\”). The exported GeoTIFF files are ready to use in advanced GIS software as we can 
see in Figure 180. 

 
Figure 180. Results of ordinary kriging imported into SAGA GIS. 
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